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Introduction to UltraPortChapter 11

About the UltraPort, UltraPort SI, and  
UltraPort Express Serial Adaptor cards

The UltraPort Serial Adaptor cards are multi-port cards which provide extra serial ports for EIA-232, 
EIA-422 and EIA-485 peripherals. These cards plug into your PC servers and provide 1,2, 4, 8 or 16 
high speed ports suitable for remote access, data collection, point of sale or any other EIA-232, EIA-
422, or EIA-485 applications. The baud rates supported on these cards are up to 921600 Kbps for 
EIA-232 interface and up to 3.686 Mbps for EIA-422 and EIA-485 interfaces. The lowest baud rate 
supported is 50 bps unless otherwise stated.
You use the UltraPort, UltraPort SI, and UltraPort Express serial adaptor cards when you want a 
robust entry level solution for the small office or point of sale applications. Typically you use 
UltraPort, UltraPort SI, and UltraPort Express serial adaptor cards because you want to add extra 
serial ports to an existing computer system rather than replacing it with the considerable cost that 
entails. Higher data rates and ESD protection in the UltraPort, UltraPort SI, and UltraPort Express 
serial adaptor cards make it suitable for any modem or ISDN TA application.

Note: To use the UltraPort, UltraPort SI, or UltraPort Express serial adaptor cards you must 
first install the card, and then install the drivers supplied with the card. You can then 
configure each card as required. The installation procedure varies for different operating 
systems. Please refer to the appropriate chapter for your operating system.
Ultraport User Guide 8



Connection accessories
Connection accessories
The connector box or cable required for the UltraPort products you are using depends on the number 
of ports and product type. For details see Chapter 7, "Cabling Information"
 9



Installing/Removing 
Host Cards And Cable 
Accessories Chapter 2

2

Introduction

This section describes the mechanical installation of the UltraPort, UltraPort SI, or UltraPort Express 
host cards and associated connector boxes and cables for 1,2, 4, 8 and 16 ports.
Ultraport User Guide 10



Installing UltraPort, UltraPort SI, and UltraPort Express cards
Installing UltraPort, UltraPort SI, and  
UltraPort Express cards

This section describes the mechanical installation of UltraPort cards.
To install an UltraPort host card proceed as follows

:

1. Turn off the power to your system and unplug the power cord.
2. Remove the system cover to expose the inside of the connector panel for host cards.
3. Insert the UltraPort card you want to install into a vacant host PCI /PCI Express card slot and 

secure in place as shown in the next picture.

4. Repeat step 3. until you have installed all the UltraPort cards you want.
5. Replace and secure the system cover.
Installation of UltraPort cards is now complete.

Note: The exact location of host card slots varies for different systems, for exact mechanical details 
of your system, refer to your system documentation

Warning
Dangerous voltages exist inside computer systems. Before 
installing host cards in your system, turn off the power supply 
and unplug the power cord.

Caution
Full anti-static precautions should be taken when handling host 
cards.
 11



Installing cables and connector boxes
Installing cables and connector boxes
This section describes the mechanical installation of cables and connector boxes to the UltraPort host 
cards for 1, 2, 4, 8 and 16 ports and includes the following:

Installing cables on UltraPort1/2, UltraPort1/2 SI and UltraPort1/2 Express cards on page 13
Installing converter cables on UltraPort4 (RJ-45) and UltraPort4 Express (RJ45) cards on 
page 13
Installing converter cables on UltraPort8i cards on page 13
Installing fan-out cables and connector boxes on UltraPort4-LP, UltraPort4 SI-LP, 
UltraPort4 Express HD, UltraPort8, UltraPort8 SI-LP and UltraPort8 Express HD cards on 
page 14
Installing fan-out cables and connector boxes on UltraPort16 and UltraPort16 SI cards on 
page 15

For information on available connectors and their pinouts and cabling, see Chapter 7, "Cabling 
Information"  
 12



Installing cables and connector boxes
Installing cables on UltraPort1/2, UltraPort1/2 SI and  
UltraPort1/2 Express cards

The UltraPort1, UltraPort1 SI and the UltraPort1 Express have a single DB9 male connector on the 
back panel and UltraPort2, UltraPort2 SI and UltraPort 2 Express cards have two DB9 male 
connectors on the back panel. There is one for each serial port and they are labelled 1 to 2. 
You can connect peripheral serial devices directly to the card by using standard RS-232 DB9 
female connectors on the adapter side of the cable you are using to connect the peripheral 
device.

Installing converter cables on UltraPort4 (RJ-45) and  
UltraPort4 Express (RJ45) cards

UltraPort4 and UltraPort4 Express cards have four RJ45 10-pin connectors on the back panel. There 
is one for each serial port and they are labelled 1 to 4.
Converter cables with the proper connector on the opposite end can be plugged into these RJ45 
connectors to provide the desired interface.

Installing converter cables on UltraPort8i cards
UltraPort8i have eight RJ12 6-pin connectors on the back panel. There is one for each serial port.
Converter cables with the proper connector on the opposite end can be plugged into these RJ12 
connectors to provide the desired interface.
 13



Installing cables and connector boxes
Installing fan-out cables and connector boxes on  
UltraPort4-LP, UltraPort4 SI-LP, UltraPort4 Express HD,  
UltraPort8, UltraPort8 SI-LP and UltraPort8 Express HD cards

UltraPort4-LP, UltraPort4 SI-LP, UltraPort4 Express HD, UltraPort8, UltraPort8 SI-LP and 
UltraPort8 Express HD cards have a single VHDCI-68 connector on the back panel. It provides the 
signals for 4 or 8 serial ports.
A fan-out cable or connector box with the proper individual connectors can be plugged into the card 
to provide the desired interface. The port numbers will be identified on the interface connectors or 
connector box

Note: The UltraPort fan-out cables and connector boxes need to be secured or supported in 
case of sudden contact or excessive weight on the cables. Please ensure that 
adequate caution is taken to avoid possible damage to the UltraPort card or Host 
system. This can be accomplished by securing the cable(s) to a rack or to the back of 
the server as shown below:
 14



Installing cables and connector boxes
Installing fan-out cables and connector boxes on  
UltraPort16 and UltraPort16 SI cards

UltraPort16 and UltraPort16 SI cards have two VHDCI-68 connectors on the back panel. Each one 
provides the signals for 8 serial ports, to provide a total of 16 ports. The connectors are labelled “1 - 
8” and “9 - 16” on the back panel, to indicate the port numbers that are provided on each connector.
A fan-out cable or connector box with the proper individual connectors can be plugged into each 
connector on the card to provide the desired interface for 8 ports. The port numbers will be identified 
on the interface connectors or connector box

Note: On an UltraPort16 and UltraPort16 SI card, the port numbers for ports on the 
connector labelled “9 - 16” will be 8 higher than the numbers given on the interface 
connectors of the fan-out cable or connector box.

Note: The UltraPort fan-out cables and connector boxes need to be secured or supported in 
case of sudden contact or excessive weight on the cables. Please ensure that 
adequate caution is taken to avoid possible damage to the UltraPort card or Host 
system. This can be accomplished by securing the cable(s) to a rack or to the back of 
the server as shown below:
 15



Removing host cards
Removing host cards
To remove an UltraPort card from your system, proceed as follows

1. Turn off the power to your system and unplug the power cord.
2. Remove the system cover to expose the inside of the connector panel for host cards.
3. Disconnect any cables or connector boxes connected to the card you want to remove.
4. Undo the securing screw for the host card you want to remove then lift the card out of its slot as 

shown in the next picture
.

5. Repeat from step 3. until you have removed all the host cards you want.
6. Replace and secure the system cover.
7. Plug in the mains lead and turn on the power.
Removal of UltraPort card is now complete.

Note: The exact location of host card slots varies for different systems, for exact mechanical details 
of your system, refer to your system documentation

Warning
Dangerous voltages exist inside computer systems. Before 
installing host cards in your system, turn off the power supply 
and unplug the power cord.

Caution
Full anti-static precautions should be taken when handling host 
cards.
 16



Installing On Microsoft 
Windows Chapter 33
Installing Drivers
General Information

You need to read this chapter if you want to install UltraPort, UltraPort SI, and UltraPort Express 
serial adaptor cards, associated hardware and software on a Microsoft Windows O/S.
The following Microsoft Windows Operating Systems are supported;

Windows 10 
Windows 8.1 
Windows Server 2012 /2012 R2 
Windows 8 
Windows 7 
Windows Server 2008 / 2008 R2 
Windows Vista 
Windows XP 
Windows Server 2003 
Windows 2000 
Windows 95/98 - See Windows 95 and Windows 98 on page 27 
Windows NT - See Windows NT on page 39

Downloading the driver from the Perle web site
You can install the UltraPort driver and utility software from the Perle web site. To do this proceed as 
follows:
1. On your PC, start the Internet browser you want to use.
2. Within your Internet browser window, select the software directory using the following URL:

http://www.perle.com/downloads 
3. Select your product under the “Serial & Parallel Cards” option.
4. Next, select your operating system. When applicable, ensure that you select the correct 

architecture (i.e. 32 bit or 64 bit).
5. To download the driver, simply click on the version number under the “Drivers” tab.
Ultraport User Guide 17
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Installing Drivers
General setup procedure
1. Install any UltraPort and cards and cables or connector boxes you require into your system. See 

Installing/Removing Host Cards And Cable Accessories on page 10.
2. Install the UltraPort, UltraPort SI, or UltraPort EXPRESS device driver software. See Installing 

device drivers and utilities onto your system on page 19.
3. If you add new UltraPort, UltraPort SI, and UltraPort Express cards, you should run Update 

Driver to make sure the new cards have the latest driver. See Adding additional cards and/or 
updating drivers on page 20.

4. If required, remove any host cards you want from your system. See Removing host cards on 
page 16.

5. Using the Windows Device Manager, configure the serial ports you have added to the system. 
See Configuring the Serial ports on page 21.
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Installing Drivers
Installing device drivers and utilities onto your system
To install or enable the UltraPort, UltraPort SI, and UltraPort Express device drivers on your system, 
proceed as follows:
1. Turn on your PC and, if required, log in.

If you have installed any new UltraPort cards Windows will detect the new hardware and try to 
install driver the drivers.
For Windows XP and older systems, a Found New Hardware wizard will be displayed. Click 
on the Cancel button.
For Windows Vista and newer systems, an Installing New Hardware balloon may appear in the 
lower right corner of the screen. Click the X to close the balloon.

2. Download the latest UltraPort/UltraPort SI/UltraPort Express driver file from the Perle website 
for your operating system:

3. Double-click the installation zip that you downloaded in step 3. This will display a list of files. 
Find the appropriate setup file and double click on it to execute it. The setup files are titled as 
follows;
pserial-setup-x86.exe for 32-bit Windows operating systems
pserial-setup-x64.exe for 64-bit Windows operating systems
pserial-setup-ia64.exe for 64-bit Windows Itanium operating systems

4. Follow the installation wizard steps:
 19



Installing Drivers
5. The general release drivers are all signed by Microsoft. In the event that you are installing a 
driver provided to you by our support team, you may get a Windows Security message. Click 
Install when the message appears.

Your UltraPort/UltraPort SI/UltraPort Express driver installation is now finished.

Adding additional cards and/or updating drivers
Whenever you add any additional UltraPort, UltraPort SI, or UltraPort Express hardware to your 
system, Windows might install the latest digitally signed driver in its database (depending on your 
Windows operating system and settings). To ensure you have the latest driver installed after you add 
new hardware, you can either:

Click Start > All Programs > Perle > Perle-Serial > Update Driver
or

Reinstall the drivers as described in Installing device drivers and utilities onto your system on 
page 19.

Note: If you are installing an unsigned driver, you may have to click through the Found New 
Hardware wizard for every UltraPort port on your system. You may click on the check 
box to “Always trust software from Perle Systems Limited” if your security policy 
allows this. This will eliminate the repeating of this security message.
 20



Configuring the Serial ports
Configuring the Serial ports
To configure UltraPort and UltraPort SI and UltraPort Express serial ports, proceed as follows:
1. Windows XP and older systems

a. On the Windows desktop, click on the Start button and select  Control Panel
b. In the Control Panel window, click on the System icon to display the System Properties 

tabbed window.
c. In the System Properties window, click on the Hardware tab to display the Hardware page.
Windows Vista and newer systems
a. On the Start page, select Control Panel.
b. In the Control Panel Window, select Hardware and Sound or Hardware to display the 

Hardware page.
2. In the Hardware page, click on Device Manager link or button.

The Device Manager window is now displayed.

3. You can click on the Multiport serial adapters icon to display the currently installed devices. 
Each entry represents an UltraPort card.

4. Now click on the Ports(COM & LPT) to view the detected ports for the UltraPort cards.
5. Double click on the port whose properties you want to view or change

The Port Properties tabbed window is now displayed.
 21



Configuring the Serial ports
6. In the Port Properties window, click on the Port Settings tab to display the Port Settings page.

7. In the Port Settings page, set the Port Number, Baud Rate and other configuration parameters 
you require.
The DSR Always On option will, when checked, cause the driver to always report the DSR 
signal as active. This is used when using a cable that does not supply the DSR signal but the 
application being used requires this signal.
 22



Configuring the Serial ports
8. If the COM port belongs to a UltraPort SI card then you can click on the Advanced button to 
access the software switchable interface modes as shown in the next diagram.

Protocol Type: The valid software switchable protocol types are EIA-232, EIA-422, EIA-485 
Full Duplex and EIA-485 Half Duplex. Each port on the UltraPort SI are 
independent of each other and therefore you may select different protocols per 
serial port.

Baud Rate 
Multiplier:

The baud rate multiplier allows the user to multiply the configured baud rate by 
1, 2, 4, 8,16 or 32, hence achieving greater speeds on the UltraPort SI serial 
interfaces. This is applicable for each protocol type selected. Baud rates for 
EIA-232 are up to 921.6 Kbps per serial port. Baud rates for EIA-422/EIA-485 
are up to 3.686 Mbps per serial port.

Slew Rate Limiting:The default setting for slew rate limiting is disabled. This will allow higher 
baud rate speeds on each EIA interface port. Slew rate limiting enabled, 
minimizes EMI and reduces reflections caused by improperly terminated 
cables. Operation in slew rate limited mode reduces the amplitudes of high-
frequency harmonics.

Line Termination: The line termination parameter is not changeable by the user in EIA-232 mode. 
However both EIA-422 and EIA-485 modes are defaulted to disabled but can 
be enabled by the user if needed.
 23



Configuring the Serial ports
EIA-485 HDX 
Local Echo: 

Local echo by default is on. This parameter applies only to EIA-485 half 
duplex mode. All characters will be echoed to the user and transmitted across 
the serial ports. Some EIA-485 applications require local echo to be enable in 
order to monitor the loopback data to determine that line contention has 
occurred. If your application cannot handle loopback data the local echo should 
be disabled.

EIA-485 TX Driver 
Control:

The default for this field is AUTO. When Auto is set the UltraPort SI will 
automatically detect the beginning and the ending of data being transmitted in 
order to enable and disable the transmit line. When the field is set to RTS it is 
the host application’s responsibility to enable and disable the transmit line via 
the RTS handshake line when it wants to send data. 

Auto EIA-485 Bit 
Delay: 

By default this field is set to 0 delay. This field is only applicable if you have 
configured EIA-485 TX Driver Control to AUTO. Values for this field are 0 
through 15 bits.

Note: The port must be closed and then opened for the new parameters to take effect.
 24



Configuring the Serial ports
9. In the FIFO Settings page, set the FIFO buffer levels using the parameters detailed in the table.

Tx FIFO Limit Sets the overall size of the Transmit FIFO buffer.You use this 
when you want to restrict the size of the buffer in order to control 
the data flow. This is useful when your application requires you to 
send small amounts of data but needs acknowledgement that the 
data has been sent. 
For example, if your application is designed to receive 4 bytes at a 
time, a larger value of say 16 would time out.
Permitted values for an UltraPort card are 1 to 64.

Tx FIFO Trigger Level Sets the level at which the com port Transmit FIFO buffer is filled 
with data each time a request for more data is made.
For example, if set to 16 bytes you get 16 bytes at a time when 
driver requests data. 
Permitted values for an UltraPort card are 8, 16, 32 and 56.

Rx FIFO Trigger Level Sets the level at which the com port Receive FIFO buffer is filled 
before the data is passed on to an application.
For example, if set to 16 bytes, 16 bytes of data are accumulated at 
a time before data is passed on to an application. The FIFO trigger 
will also time out if the level is not achieved within two character 
periods of the last byte received.
Permitted values for an UltraPort card are 8, 16, 56 and 60.
 25



Removing Drivers
10. Within the Serial Port properties window, click on the OK button to save changes and close the 
window.

The configuration process is now complete.

Removing Drivers
To uninstall the UltraPort serial adapter driver, do the following:
1. Windows XP and older systems

a. On the Windows desktop, click on the Start button and select  Control Panel
b. In the Control Panel window, double click on the Add or Remove Programs icon to display 

the Add or Remove Programs window.
c. Scroll through the list and click on the Perle Perle-Serial Driver entry. Click on the 

Remove button and then follow the instructions on screen to uninstall the UltraPort driver.
Windows Vista and newer systems
a. On the Start menu or page, select Control Panel.
b. In the Control Panel Window, select Uninstall a program to display the Uninstall a 

program window.
c. Scroll through the list and double click on the Perle Perle-Serial Driver entry and follow 

the instructions on screen to uninstall the UltraPort driver.

High Flow Control 
Threshold

Sets the level at which data flow is suspended. 
If the limit is exceeded, the driver will stop collecting data.
For UltraPort, value is read only, set automatically from FIFO 
trigger level.

Low Flow Control 
Threshold

Sets the level at which data flow is resumed.
If the low flow threshold is exceeded, the driver requests more 
data. 
For UltraPort, value is read only, set automatically from FIFO 
trigger level.

Note: To restore the default settings, use the Restore Defaults button.
 26



Windows 95 and Windows 98
Windows 95 and Windows 98
Introduction

This section tells you how to install UltraPort and UltraPort SI only host cards, software drivers and 
utilities under the Windows 95 and Windows 98 operating systems and includes the following:

General Installation Procedure on page 27
Installing Device Drivers And Utilities on page 28
Configuring your serial ports on Win 95/98 on page 31
Removing Drivers and Utilities From Your System on page 37.

General Installation Procedure
The general procedure for installing UltraPort and UltraPort SI only cards under the Windows 95/98 
operating systems is as follows:
1. Install any UltraPort and UltraPort SI cards and cables or connector boxes you require into your 

system. See Installing UltraPort, UltraPort SI, and UltraPort Express cards on page 11.
2. Using the Windows Found New Hardware Wizard, install the UltraPort or UltraPort SI device 

driver software. See Installing Device Drivers And Utilities on page 28

3. If required, remove any host cards you want from your system. See Removing Drivers and 
Utilities From Your System on page 37.

4. Using the Windows Device Manager, configure the serial ports you have added to the system. 
See Configuring your serial ports on Win 95/98 on page 31.

Note: The UltraPort and UltraPort SI device drivers for Windows 95/98 are not included on your 
Windows 95 or Windows 98 CDROM
 27



Windows 95 and Windows 98
Installing Device Drivers And Utilities
To install or enable the UltraPort and UltraPort SI device drivers on your system proceed as follows:
1. Turn on your PC and if required, log in.

If you have installed any new UltraPort or UltraPort SI cards, a Found New Hardware - “PCI 
Serial Controller” message is briefly shown followed by the Add New Hardware Wizard 
window as shown below:

2. Proceed by clicking Next and the following Add New Hardware Wizard window will appear: 
 28



Windows 95 and Windows 98
3. Proceed again by clicking Next and the following Add New Hardware Wizard window will 
appear 

4. Inset the Perle CD and check the Specify a location check box. Now either browse to, or type in 
the following path d:\driversultraport\win9x\x.yy. Where x.yy is the windows 95/98 driver 
version number. Then click Next and the following Add New Hardware Wizard window will 
appear:
 29



Windows 95 and Windows 98
5. Proceed by clicking Next and the final Add New Hardware Wizard window will appear as 
below:

6. Proceed by clicking Finish. Windows will now copy all the files needed for the device driver. 
After the driver installation is complete, the driver will automatically find all of the serial ports 
associated with the UltraPort or UltraPort SI card. A series of New Hardware Found messages 
will be temporarily displayed for every port found.

Installation of the device drivers and utilities is now complete
.
Note: Your system does not need to be restarted to start using the newly added serial ports
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Configuring your serial ports on Win 95/98
To configure UltraPort or UltraPort SI serial ports proceed as follows:
1. In the windows desktop, click on the Start button and select Settings > Control panel.

The control panel window is now displayed.

2. In the control panel window, double click on the System icon. The System Properties tabbed 
window is displayed.

Note: You can also display the System Properties tabbed window by right clicking on the My 
Computer icon on your desktop and selecting the Properties menu option.
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3. In the System Properties tabbed window, click on the Device Manager tab.
The Device Manager page is now displayed.

4. In the Device Manager page, double click on the device whose properties you wish to view.
The properties tabbed window for the selected device is now displayed.
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5. In the properties window, click on the Port Settings tab.
The Settings page is now displayed.

6. In the Port Settings page, select the configuration values you want and either click on the OK 
button or click on the FIFO Settings tab to display FIFO configuration settings for the device 
driver.
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7. The FIFO Settings page is now displayed as shown in the next picture

8. In the FIFO Settings page, select the configuration values you want and either click on the OK 
button or, if the COM port belongs to a UltraPort SI card, then you can click on the Protocol 
Settings tab to access the software switchable interface modes.In

Caution
It is strongly recommended that you do not make changes to the FIFO 
trigger levels or com port name unless you have a valid reason to do so.

 
Selects the port 
name for a given 
device.  
 
Allows you to select 
the default port 
name or change it to 
any unused port 
name. 
 
Default display is 
the currently 
assigned port name.
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9. The Protocol Settings page is now displayed as shown in the next picture

10. In the Protocol Settings page, select the configuration values you want and click on the OK 
button.

Protocol Type: The valid software switchable protocol types are EIA-232, EIA-422, EIA-485 
Full Duplex and EIA-485 Half Duplex. Each port on the UltraPort SI are 
independent of each other and therefore you may select different protocols per 
serial port.hh

Baud Rate 
Multiplier:

The baud rate multiplier allows the user to multiply the configured baud rate by 
1, 2, 4, 8,16 or 32, hence achieving greater speeds on the UltraPort SI serial 
interfaces. This is applicable for each protocol type selected. Baud rates for 
EIA-232 are up to 921.6 Kbps per serial port. Baud rates for EIA-422/EIA-485 
are up to 3.686 Mbps per serial port.

Slew Rate Limiting:The default setting for slew rate limiting is disabled. This will allow higher 
baud rate speeds on each EIA interface port. Slew rate limiting enabled, 
minimizes EMI and reduces reflections caused by improperly terminated 
cables. Operation in slew rate limited mode reduces the amplitudes of high-
frequency harmonics.

Line Termination: The line termination parameter is not changeable by the user in EIA-232 mode. 
However both EIA-422 and EIA-485 modes are defaulted to disabled but can 
be enabled by the user if needed.
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Re-configuration of ports is now complete.

EIA-485 HDX 
Local Echo: 

Local echo by default is on. This parameter applies only to EIA-485 half 
duplex mode. All characters will be echoed to the user and transmitted across 
the serial ports. Some EIA-485 applications require local echo to be enable in 
order to monitor the loopback data to determine that line contention has 
occurred. If your application cannot handle loopback data the local echo should 
be disabled.

EIA-485 TX Driver 
Control:

The default for this field is AUTO. When Auto is set the UltraPort SI will 
automatically detect the beginning and the ending of data being transmitted in 
order to enable and disable the transmit line. When the field is set to RTS it is 
the host application’s responsibility to enable and disable the transmit line via 
the RTS handshake line when it wants to send data. 

Auto EIA-485 Bit 
Delay: 

By default this field is set to 0 delay. This field is only applicable if you have 
configured EIA-485 TX Driver Control to AUTO. Values for this field are 0 
through 15 bits.

Note: The port must be closed and then opened for the new parameters to take effect.
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Removing Drivers and Utilities From Your System
To remove drivers and utilities from your system proceed as follows:
1. In the windows desktop, click on the Start button and select Settings > Control panel.

The control panel window is now displayed.
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2. In the control panel window, double click on the System icon.
The System Properties tabbed window is now displayed as shown in the next picture.

3. In the System Properties tabbed window, click on the Device Manager tab
The Device Manager page is now displayed.

4. In the Device Manager page, click on the Perle Multi-function adapter that you wish to remove, 
highlighting it then press the Remove button.

The selected device is now removed from the system.

Warning
If you remove the devices but do not remove the hardware, the devices 
will be re-installed when you next re-boot the machine or run the 
Hardware Wizard.
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Windows NT
The procedure for installing and configuring host cards, drivers software and associated utilities for 
the Windows NT operating system is as follows 

1. Install any UltraPort and UltraPort SI cards, cables or connector boxes you require into your 
system. See Installing UltraPort, UltraPort SI, and UltraPort Express cards on page 11.

2. If required, remove any host cards you want from your system. See Removing host cards on 
page 16.

3. Use the PortDirector software to update your system with the revised number and type of host 
cards. See The PortDirector user guide part number 5500028 for further details.

Your system can now use the serial adaptor cards you have installed. 

Note: The Perle PortDirector software contains drivers for the UltraPort and UltraPort SI host cards 
only. 
You will need to install the PortDirector for Windows NT on your system in order to use the 
UltraPort and UltraPort SI host cards. 
See the PortDirector user guide part number 5500028 for further details.
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Installing Drivers
Introduction

You need to read this chapter if you want to install UltraPort, UltraPort SI, and UltraPort Express 
serial adaptor cards, associated hardware and software on a Linux O/S.
The following versions of Linux are supported;

Linux 3.x
Linux 2.6.x
Linux Mandriva 2007, 2009, 2011
Linux OpenSUSE 10, 11, 12.1,12.3
Linux Red Hat Fedora 7, 9, 16-18
Linux Red Hat Enterprise 5.2, 6.2, 6.4
Linux SUSE Enterprise 10 SP2, 11 SP2
Linux Debian 4.0r4, 6.0.4, 6.0.7
Linux 2.4.x
Linux 2.2.16+
Ultraport User Guide 40
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General installation procedure for Linux
The general procedure for installing and configuring host cards, driver software and associated 
utilities for the Linux operating system is as follows:
1. Install any UltraPort cards you require into your system. See Installing/Removing Host Cards 

And Cable Accessories on page 10.
2. Install the UltraPort Linux drivers onto your system using the procedures described in 

Downloading the driver from the Perle web site on page 41.
3. Create devices for the required ports using the procedures detailed in Creating devices for the 

attached ports on page 43.
Your system can now use the UltraPort serial adaptor cards you have installed.

Downloading the driver from the Perle web site
You can install the UltraPort driver and utility software from the Perle web site. To do this proceed as 
follows:
1. On your PC, start the Internet browser you want to use.
2. Within your Internet browser window, select the software directory using the following URL:

http://www.perle.com/downloads 

3. Select your product under the “Serial & Parallel Cards” option.
4. Next, select your operating system.
5. Driver packages are available as Source RPM or Compressed TAR. Select the format you wish 

to use. To download the driver package, click on the version number in the “Drivers” tab.

Installing Drivers onto your system
The UltraPort cards and UltraPort SI installed on Linux machines use the perle-serial driver for 
Linux. The driver supports the Linux kernel versions 2.2, 2.4, 2.6 and 3.x. The kernel header files are 
needed for kernel 2.2 and 2.4. For the 2.6 kernel and later, a configuration kernel source tree and a set 
of makefile rules describing how the modules are built is required.
The UltraPort Express cards installed on Linux machines use the perle-serial driver for Linux. The 
driver supports the Linux kernel versions 2.4, 2.6 and 3.x. The Kernel header files are needed for 
kernel 2.4. For the 2.6 kernel and later, a configuration kernel source tree and a set of makefile rules 
describing how the modules are build is required
The driver is supplied in both source RPM package format and a compressed tar file. The procedure 
for installation of each format is as follows:
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Uninstall Patch Versions
The Perle-Serial driver version 2.0 and higher is a standalone kernel module. If previous patches have 
been made to the kernel for the UltraPort card, then these patches must be uninstalled before the new 
driver module can be installed.
1. Find the UltraPort patch files to the kernel. Remove the patches from the kernel source files by 

entering the following commands:
cd /usr/src/linux 
patch –R –p1 < <path to patches>/<patch file>

2. Recompile and install the kernel based on your specific system. For help on this procedure please 
refer to your LINUX documentation.

3. The new Perle-Serial software can now be installed

Install from Source RPM
1. Log in to the LINUX system as root user. 

2. At the LINUX prompt, copy the supplied perle-serial-<version>-<release>.src.rpm file onto 
your system in the /tmp directory.

3. Install the source rpm by typing the following command:
rpm –ivh perle-serial-<version>-<release>.src.rpm

4. Build the binary RPM package for your system by entering the following commands:
cd <packages directory>/SPECS
<rpm build command> -bb perle-serial-<version>.spec

5. Install the binary RPM which was just created. Enter the following commands:
cd <packages directory>/RPMS/<arch>
rpm –ivh perle-serial-<version>-<release>.<arch>.rpm

The <arch> value is the architecture of your LINUX machine such as “i386” or “alpha”.

Install from Tar File
1. Log in to the LINUX system as root user. 
2. At the LINUX prompt, copy the supplied perle-serial.tgz file onto your system in the /tmp 

directory.
3. Unpack the file using the command:

tar –xzvf perle-serial-<version>-<release>.tgz

4. Build and install the perle-serial software by entering the following commands
cd /tmp/perle-serial-<version>-<release>
make

Note: If more than one patch file was added, then remove them in the reverse order that they were 
applied. (i.e. If the ultraport.patch-x.y.z-2.4.x was added and then the ultraport.IO8mode-
x.y.z-2.4.x was added, remove the ultraport.IO8mode patch first.)

Note: The <packages directory> path name in the following instructions will be different 
depending on the LINUX distribution you have installed. For example:
 Redhat might be:  /usr/src/redhat
 Suse might be: /usr/src/packages
 Later rpm versions will create a directory:  /<user home directory>/rpmbuild.
The <rpm build command> will change depending on the version of the RPM utilities 
installed. For newer versions (i.e. 4.2) , the <rpm build command> is “rpmbuild”. For 
older versions use “rpm”
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Creating devices for the attached ports
After the UltraPort cards and the new driver have been installed, terminal devices will need to be 
created for the added ports. This can be done be using the ps_addports utility.
To use the ps_addports script, enter the following command:

ps_addports m n

where:
m is the first port device (starting at 0)
n is the last port device to add.

The port devices will be created in the /dev directory and will have the following format:
/dev/ttyPSnn

where nn is the 2 digit port number.
The perle-serial driver has been installed so that it will automatically be loaded the first time an 
UltraPort device is used. However, if more than one UltraPort card has been installed in the Linux 
machine, then the driver can be manually loaded to determine which terminal device numbers have 
been assigned to each card. 
To load the driver, enter the command:

modprobe perle-serial

Review the messages in the file /var/log/messages.
Once the port devices have been created, they may be used as standard LINUX serial TTYs.

UltraPort 8i RTS/DTR option
The Perle UltraPort8i can only support either RTS or DTR. There is a utility included with this driver 
to configure which signal will be active. The configuration is stored in the modules.conf file. 
The utility is used as follows:

set_io8_rts off

This is the default action. The driver will use the pin as "DTR" when the tty is in software handshake 
mode. 

set_io8_rts on

If this option is used or hardware handshake is on, the pin will always be RTS.

Note: The perle serial module will have to be unloaded and reloaded for the RTS/CTS option to 
take effect.
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Setultrap Interface Protocol Configuration Utility 
(UltraPort SI only)

Perle provides a command line utility that allows the user to configure each UltraPort SI serial ports 
for features EIA-232, EIA-422, EIA-485 full duplex and EIA-485 half duplex.

Command Line Interface
setultrap -f device_name -l

setultrap -f device_name -x baud-multiplier

setultrap -f device_name -m 232 [-s fast|slow]

setultrap -f device_name -m 422 [-s fast|slow] [-t term|unterm]

setultrap -f device_name -m 485fdx [-s fast|slow] [-t term|unterm] [-a auto|rts] 
[-b 0-15]

setultrap -f device_name -m 485hdx [-s fast|slow] [-t term|unterm]  
[-e echoon|echooff] [-a auto|rts] [-b 0-15]

-l list protocol configuration for serial device(s)

-x set baudrate multiplier for serial devices(s)

-m set interface protocol for serial device(s)

:

Note: The default interface protocol for the Perle UltraPort SI cards is EIA-232.

Option description
Configuration 
option 232 422 485hdx 485fdx

specifies the port to apply 
the configuration option to

-f required required required required

Lists the serial ports 
configuration

-l optional optional optional optional

Interface mode -m default
232

optional
422

optional
485hdx

optional
485fdx

Baud rate multiplier -x optional
(1,2,4,8,
16,32)

optional
(1,2,4,8,
16,32)

optional
(1,2,4,8,
16,32)

optional
(1,2,4,8,
16,32)

Slew rate limiting -s optional
fast/slow

optional
fast/slow

optional
fast/slow

optional
fast/slow

Line termination -t N/A optional
term/unterm

optional
term/unterm

optional
term/unterm

EIA-485 HDX local echo -e N/A N/A optional
echoon/echoff

N/A

EIA-485 TX Driver 
Control

-a N/A N/A optional
auto/rts

optional
auto/rts

Auto EIA-485 bit delay -b N/A N/A optional
( 0 -15)

optional
( 0 -15)
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-f Specifies the port the action should be taken on. 
/dev/ttyPS1 - specifies port 1 
/dev/ttyPS1,/dev/ttyPS64 -specifies port 1 through port 64 (ranges are separated by a 
comma)

-l Lists protocol configuration for each serial port configured on the UltraPort SI. 
/dev/ttyPS1 232 slow term 1 
/dev/ttyPS1 485fdx fast term auto 5 1 
The first example shows a device named ttyPS1 configured for protocol mode EIA-232, slew 
rate limiting is set to slow, termination is on, and the baud rate multiplier is 1  
The second example shows device named ttyPS1 configured for protocol mode EIA-485fdx, 
slew rate limiting is set to fast, termination is on, EIA-485 HDX TX Driver Control is set to 
auto with bit delay of 5 bits and the baud rate multiplier is 1

- m Interface mode: The valid software switchable protocol types are EIA-232, EIA-422, EIA-485 
Full Duplex and EIA-485 Half Duplex. Each port on the UltraPort SI are independent of each 
other and therefore you may select different protocols per serial port.

-x Baud Rate multiplier: The baud rate multiplier allows the user to multiply the configured 
baud rate by 1, 2, 4, 8,16 or 32, hence achieving greater speeds on the UltraPort SI serial 
interfaces. This is applicable for each protocol type selected. Baud rates for EIA-232 are up to 
921.6 Kbps per serial port. Baud rates for EIA-422/EIA-485 are up to 3.686 Mbps per serial 
port.

-s Slew Rate Limiting: The default setting for slew rate limiting is disabled. This will allow 
higher baud rate speeds on each EIA interface port. Slew rate limiting enabled, minimizes EMI 
and reduces reflections caused by improperly terminated cables. Operation in slew rate limited 
mode reduces the amplitudes of high-frequency harmonics.

-t Line Termination: The line termination parameter is not changeable by the user in EIA-232 
mode. However both EIA-422 and EIA-485 modes are defaulted to disabled but can be enabled 
by the user if needed.

-e EIA-485 HDX Local Echo: Local echo by default is on. This parameter applies only to EIA-
485 half duplex mode. All characters will be echoed to the user and transmitted across the serial 
ports. Some EIA-485 applications require local echo to be enable in order to monitor the 
loopback data to determine that line contention has occurred. If your application cannot handle 
loopback data the local echo should be disabled.

-a EIA-485 TX Driver Control: The default for this field is AUTO. When Auto is set the 
UltraPort SI will automatically detect the beginning and the ending of data being transmitted in 
order to enable and disable the transmit line. When the field is set to RTS it is the host 
application’s responsibility to enable and disable the transmit line via the RTS handshake line 
when it wants to send data. 

-b Auto EIA-485 Bit Delay: By default this field is set to 0 delay. This field is only applicable if 
you have configured EIA-485 TX Driver Control to AUTO. Values for this field are 0 through 
15 bits.

-h  Help: Displays the setultrap usage screen
.

Note: The port must be closed and then opened for the new parameters to take effect.
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Examples
The following examples show typical user applications.
Example 1: List options configured for serial port 1 through 16:

etc/setultrap -f /dev/ttyPS0,/dev/ttyPS15 -l 

Example 2: Set serial port 1 through 16 to interface type EIA-422
etc/setultrap -f /dev/ttyPS0,/dev/ttyPS15 -m 422 

Example 3: Configure ports 1 to 4 to EIA-485 full duplex
etc/setultrap -f /dev/ttyPS0,/dev/ttyPS3 -m 485fdx 

Example 4: Set serial port ttyPS1 to EIA-485 half duplex termination enabled, control bit-delay 5
etc/setultrap -f /dev/ttyPS1 -m 485hdx -t term -b 5 

These commands may be added to a startup script to cause them to run automatically whenever the 
system is started. A sample commented out startup script is (/etc/init.d/rc.setultrap) supplied with this 
driver.

Uninstalling the UltraPort Driver for Linux

Uninstalling an RPM Installation
To uninstall the driver enter the following command:

rpm -e perle-serial

Uninstalling a Tar File Installation
To uninstall the driver enter the following commands:
1. Move to the directory where you previously installed the Perle-Serial driver. For example:

cd /tmp/perle-serial-<version>-<release>

2. For Perle-Serial driver up to 3.4.x
Type the following command:

./uninstall.sh

For Perle-Serial driver 3.5 and later
make uninstall
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Installing The Driver Package
Introduction

You need to read this chapter if you want to install UltraPort, UltraPort SI, and UltraPort Express 
serial adaptor cards, associated hardware and software on a Solaris O/S.
The following versions of Solaris are supported;

Solaris Intel, 32 bit
Solaris Intel, 64 bit
Solaris SPARC, 32 bit
Solaris SPARC, 64 bit

Downloading the driver from the Perle web site
You can install the UltraPort driver and utility software from the Perle web site. To do this proceed as 
follows:
1. On your PC, start the Internet browser you want to use.
2. Within your Internet browser window, select the software directory using the following URL:

http://www.perle.com/downloads 

3. Select your product under the “Serial & Parallel Cards” option.
4. Next, select your operating system.
5. To download the driver package, click on the version number in the “Drivers” tab.
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General installation procedure for Solaris
The general procedure for installing and configuring host cards, drivers software and associated 
utilities for the Solaris operating system is as follows:
1. Install any UltraPort cards you require into your system. See Installing/Removing Host Cards 

And Cable Accessories on page 10 

2. If required, install the Solaris drivers and utilities onto your system using the procedures 
described in Installing drivers and utilities on page 49.

3. If required, remove any host cards you want from your system. See Installing/Removing Host 
Cards And Cable Accessories on page 10.

4. For Solaris 9 and earlier OS versions, you can use the admintool utility to configure the serial 
ports you have added to the system. See Configuring serial ports using the Admintool on 
page 50.

5. For Solaris 10 you can use the Solaris Management Console to configure your serial ports. See 
Using The Solaris Management Console For Solaris 10 on page 54.

6. For Solaris 11, serial port logins are configured using the SMF service "svc:/system/console-
login". See Using SMF Services For Solaris 11 on page 57.

Your system can now use the serial adaptor cards you have installed. If required, you can reconfigure 
serial ports following initial installation. 

Note: Once you have installed the drivers, if you add or remove any host cards the operating 
system will update the kernel accordingly using the startcomf program. 
startcomf is run automatically during boot up and checks to see if any host cards have 
been added or removed since the last time the system was powered up. If anything has 
changed the files which identify the ports and terminals are updated.
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Installing drivers and utilities
To install the device drivers and utilities for the Solaris operating system proceed as follows:
1. Login to your system as root.
2. Copy the downloaded driver file to the /tmp directory.
3. At the command prompt, type: 

pkgadd -d /tmp/fast-sol<osver>-x.y.z.<arch>.pkg comf

where: - <osver> is the Solaris OS version number, either 10 or 11. osver 10 is to be used for 
Solaris 10 and older versions of the OS. osver 11 is to be used for Solaris 11 and 
newer versions of the OS.

- x.y.z is the version number of the driver
- <arch> is the Solaris architecture, either i386 for Intel or sparc for Sparc stations.

4. Press the Enter key. 
The system now installs the driver and displays a series of messages ending with a successful 
installation message.

Upon installation of the drivers, your UltraPort cards are ready to use.

Serial port naming conventions
Each serial port has three device nodes associated with it. Each node takes the form of a file which 
you can access from operating system utilities and user applications. Details of these nodes are shown 
in the following table where:

x is the card number (1-4) 
y is a lower case letter in the range a-p. a is port 1, ..., p is port 16. 

These mappings can be altered by careful modification of the mkdev and startcomf scripts in 
/usr/lib/comf/ directory.

Note: A re-boot of your system is not necessary as the drivers for your UltraPort card are 
dynamically loadable and will be loaded as soon as any software attempts to access the 
associated devices.

Device name Function Description

/dev/comfxy
/dev/term/comfxy

Normal communications port 
for local “tty” devices.

Indicates normal 
communications port behavior.

/dev/cua/comfxy Modem port Indicates that an open on a port 
will not complete unless DCD 
is present
 49



Installing The Driver Package
Configuring serial ports using the Admintool
The software provided with the Solaris operating system includes a utility called admintool which 
allows you to configure the extra serial ports you have added to your system.
To configure serial ports with admintool proceed as follows: 

1. At the command prompt, type admintool
The Admintool: Users window is now displayed as shown in the next picture.
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2. In the Admintool: Users window, click on Browse > Serial Ports.
The Admintool: Serial Ports window is now displayed showing all serial ports currently present 
on the system
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3. .In the Admintool: Serial Ports window, select the port you want to configure. To configure the 
port, click on Edit > Modify.
The Admintool: Modify Serial Port window is now displayed.

In the Admintool: Modify Serial Port window you can click on the Expert button to show 
more fields, as shown in the next picture.
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4. In the Admintool: Modify Serial Port window, set the parameters you require.

5. In the Admintool: Modify Serial Port window, click on OK to accept the changes you have 
made and close the window.

6. Repeat steps 3. to 5. until you have configured the serial ports for all the host cards you require.
7. In the Serial Manager menu click on Host > Quit to quit Serial Manager and close the window.

Note: Because the system does not support the selection of speeds above 460800 bps, lower 
baud rates have been permanently remapped to support higher port speeds. Remapped 
speeds are shown in the next table.Therefore the lowest baud rate supported is 75 bps

Selected speed (bps) Actual speed (bps)

50 921600
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Using The Solaris Management Console For Solaris 10
This sections describes how to add logins and remove logins using the Solaris Management Console 
for Solaris version 10. 

Adding Logins to Serial Ports
You can add a login on a serial port using the Solaris Management Console as follows:
1. In the Solaris desktop, click on the Tools toolbar arrow to get the Tools menu as shown below.
2. Select Solaris Management Console to start the application.

3. In the Solaris Management Console window, select Management Tools, Devices and 
Hardware, Serial Ports in the left-hand navigation tree. You will be prompted to login as root. 
After you have successfully logged in, the Solaris Management Console displays.
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4. Double-click the port that you want to configure as a login port. On the Basic tab, Enable the 
Service Status. Optionally type in a new Terminal Type, Login Prompt, and/or Baud Rate. 
Note that the Baud Rate field is actually a /etc/ttydefs label; for example, 115200E would 
be valid.

5. On the Advanced tab, select Hardware and change the Port Monitor to comf (the Ultraport Port 
monitor).

Note: Because the system does not support the selection of speeds above 460800 bps, lower 
baud rates have been permanently remapped to support higher port speeds. Remapped 
speeds are shown in the next table.Therefore the lowest baud rate supported is 75 bps

Selected speed (bps) Actual speed (bps)

50 921600
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Removing Terminals
To remove a terminal on a serial port use the Solaris Management Console as follows:
1. In the Solaris desktop, click on the Tools toolbar arrow to get the Tools menu as shown below.
2. Select Solaris Management Console to start the application.

3. In the Solaris Management Console window, select Management Tools, Devices and Hardware, 
Serial Ports in the left-hand navigation tree. You will be prompted to login as root. After you 
have successfully logged in, the Solaris Management Console displays.

4. Right-click on the terminal you want to remove and select Delete Port Service and then click 
Ok.
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Using SMF Services For Solaris 11
This section will give a brief example of how to add logins and remove logins using the SMF service 
/system/console-login. For more details see the Solaris 11 documentation. 

Adding Logins to Serial Ports
To add a login on an UltraPort serial port enter the following commands:
# svccfg -s svc:/system/console-login "add term1"
# svccfg -s svc:/system/console-login:term1 "addpg ttymon application" 
# svccfg -s svc:/system/console-login:term1 "setprop ttymon/device = /dev/term/comf1a" 
# svccfg -s svc:/system/console-login:term1 "setprop ttymon/terminal_type = vt100" 
# svccfg -s svc:/system/console-login:term1 "setprop ttymon/label = Perle_Z" 
# svcadm refresh svc:/system/console-login:term1 
# svcadm enable svc:/system/console-login:term1 

The commands above creates a new console-login service called term1 but any name can be used. 
The service is assigned the UltraPort device /dev/term/comf1a. A label from the /etc/ttydefs file is 
then configured for this port to assign baud rate and other serial port parameters. In this example the 
label Perle_Z is used which was added to the ttydefs file by the UltraPort installation process.

Removing Terminals
To remove a terminal on a serial port you should first logout of any active session on the terminal and 
then enter the following commands on a system console:
# svcadm disable svc:/system/console-login:term1
# svccfg -s svc:/system/console-login delete term1

Note: Because the system does not support the selection of speeds above 460800 bps, lower 
baud rates have been permanently remapped to support higher port speeds. Remapped 
speeds are shown in the next table.Therefore the lowest baud rate supported is 75 bps

Selected speed (bps) Actual speed (bps)

50 921600
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Setultrap Interface Protocol Configuration Utility  
(UltraPort SI only)

Perle provides a command line utility that allows the user to configure each UltraPort SI serial ports 
for features EIA-232, EIA-422, EIA-485 full duplex and EIA-485 half duplex.

Command Line Interface
setultrap -f device_name -l

setultrap -f device_name -x baud-multiplier

setultrap -f device_name -m 232 [-s fast|slow]

setultrap -f device_name -m 422 [-s fast|slow] [-t term|unterm]

setultrap -f device_name -m 485fdx [-s fast|slow] [-t term|unterm] [-a auto|rts] 
[-b 0-15]

setultrap -f device_name -m 485hdx [-s fast|slow] [-t term|unterm]  
[-e echoon|echooff] [-a auto|rts] [-b 0-15]

-l list protocol configuration for serial device(s)

-x set baudrate multiplier for serial devices(s)

-m set interface protocol for serial device(s)
:

Note: The default interface protocol for the Perle UltraPort SI cards is EIA-232.

Option description
Configuration 
option 232 422 485hdx 485fdx

specifies the port to apply 
the configuration option to 

-f required required required required

Lists the serial ports 
configuration

-l optional optional optional optional

Interface mode -m default
232

optional
422

optional
485hdx

optional
485fdx

Baud rate multiplier -x optional
(1,2,4,8,
16,32)

optional
(1,2,4,8,
16,32)

optional
(1,2,4,8,
16,32)

optional
(1,2,4,8,
16,32)

Slew rate limiting -s optional
fast/slow

optional
fast/slow

optional
fast/slow

optional
fast/slow

Line termination -t N/A optional
term/unterm

optional
term/unterm

optional
term/unterm

EIA-485 HDX local echo -e N/A N/A optional
echoon/echoff

N/A

EIA-485 TX Driver 
Control

-a N/A N/A optional
auto/rts

optional
auto/rts

Auto EIA-485 bit delay -b N/A N/A optional
(0 -15)

optional
(0 -15)
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-f Specifies the port the action should be taken on. 
/dev/comf1a - specifies port 1 
/dev/comf2a,/dev/comf2p -specifies port 1 through port 64 on card 2

-l Lists protocol configuration for each serial port configured on the UltraPort SI. 
/dev/comf1a 232 slow term 1 
/dev/comf1a 485fdx fast term auto 5 1 
The first example shows a device named ttyz1 configured for protocol mode EIA-232, slew rate 
limiting is set to slow, termination is on, and the baud rate multiplier is 1  
The second example shows device named ttyz1 configured for protocol mode EIA-485fdx, 
slew rate limiting is set to fast, termination is on, EIA-485 HDX TX Driver Control is set to 
auto with bit delay of 5 bits and the baud rate multiplier is 1

- m Interface mode: The valid software switchable protocol types are EIA-232, EIA-422, EIA-485 
Full Duplex and EIA-485 Half Duplex. Each port on the UltraPort SI are independent of each 
other and therefore you may select different protocols per serial port.

-x Baud Rate multiplier: The baud rate multiplier allows the user to multiply the configured 
baud rate by 1, 2, 4, 8,16 or 32, hence achieving greater speeds on the UltraPort SI serial 
interfaces. This is applicable for each protocol type selected. Baud rates for EIA-232 are up to 
921.6 Kbps per serial port. Baud rates for EIA-422/EIA-485 are up to 3.686 Mbps per serial 
port.

-s Slew Rate Limiting: The default setting for slew rate limiting is disabled. This will allow 
higher baud rate speeds on each EIA interface port. Slew rate limiting enabled, minimizes EMI 
and reduces reflections caused by improperly terminated cables. Operation in slew rate limited 
mode reduces the amplitudes of high-frequency harmonics.

-t Line Termination: The line termination parameter is not changeable by the user in EIA-232 
mode. However both EIA-422 and EIA-485 modes are defaulted to disabled but can be enabled 
by the user if needed.

-e EIA-485 HDX Local Echo: Local echo by default is on. This parameter applies only to EIA-
485 half duplex mode. All characters will be echoed to the user and transmitted across the serial 
ports. Some EIA-485 applications require local echo to be enable in order to monitor the 
loopback data to determine that line contention has occurred. If your application cannot handle 
loopback data the local echo should be disabled.

-a EIA-485 TX Driver Control: The default for this field is AUTO. When Auto is set the 
UltraPort SI will automatically detect the beginning and the ending of data being transmitted in 
order to enable and disable the transmit line. When the field is set to RTS it is the host 
application’s responsibility to enable and disable the transmit line via the RTS handshake line 
when it wants to send data. 

-b Auto EIA-485 Bit Delay: By default this field is set to 0 delay. This field is only applicable if 
you have configured EIA-485 TX Driver Control to AUTO. Values for this field are 0 through 
15 bits.

-h  Help: Displays the setultrap usage screen
.

Note: The port must be closed and then opened for the new parameters to take effect.
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Examples
The following examples show typical user applications.
Example 1: List options configured for serial port 1 thougth 16:

etc/setultrap -f /dev/comf1a,/dev/comf1p -l 

Example 2: Set serial port 1 through 16 to interface type EIA-422
etc/setultrap -f /dev/comf1a,/dev/comf1p -m 422 

Example 3: Configure ports 1 to 4 to EIA-485 full duplex
etc/setultrap -f /dev/comf1a,/dev/comf1d -m 485fdx 

Example 4: Set serial port comf1a to EIA-485 half duplex termination enabled, control bit-delay 5
etc/setultrap -f /dev/comf1a -m 485hdx -t term -b 5 

These commands may be added to a startup script or put at the end of the /etc/inittab file, to cause 
them to run automatically whenever the system is started. A sample commented out startup script is 
(/etc/init.setultrap) supplied with this driver.

Removing drivers and utilities from your system
To remove the software drivers from your system under the Solaris operating system proceed as 
follows:
1. At the command prompt, type pkgrm comf and press Enter 
The driver and associated utilities are now removed from your system.
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Introduction

You need to read this chapter if you want to install UltraPort, UltraPort SI, and UltraPort Express 
serial adaptor cards, associated hardware and software on SCO O/S.
The following SCO Operating Systems are supported;

SCO Open Server 5
SCO Open Server 6
SCO Unixware

Downloading the driver from the Perle web site
You can install the UltraPort driver and utility software from the Perle web site. To do this proceed as 
follows:
1. On your PC, start the Internet browser you want to use.
2. Within your Internet browser window, select the software directory using the following URL:

http://www.perle.com/downloads 
3. Select your product under the “Serial & Parallel Cards” option.
4. Next, select your operating system.
5. To download the driver, simply click on the version number under the “Drivers” tab.
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Installing under SCO OpenServer5 and 
OpenServer6.
General installation procedure for SCO OpenServer

The general procedure for installing and configuring host cards, drivers software and associated 
utilities for the SCO OpenServer operating system is as follows:
1. Install any UltraPort, UltraPort SI, and UltraPort Express cards you require into your system. See 

Installing/Removing Host Cards And Cable Accessories on page 10 
2. Install the SPEED SCO OpenServer drivers and utilities onto your system using the procedures 

described in Installing device drivers and utilities on page 63.
3. If required, remove any host cards you want from your system. See Installing/Removing Host 

Cards And Cable Accessories on page 10.
4. Using the Port Configuration tool, configure the serial ports you have added to the system. See 

Configuring serial ports on page 80.
Your system can now use the serial adaptor cards you have installed. If required, you can reconfigure 
serial ports following initial installation.
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Installing device drivers and utilities
To install the SPEED device drivers and utilities for the SCO OpenServer operating system proceed 
as follows:
1. Login to your system as super user.
2. Load the CDROM into your system CD drive.
3. At the command prompt, make a directory for your installation by typing:

mkdir /cdrom

4. Mount the CDROM file system using the following commands:
mount -f ISO9660 -r /dev/cd0 /cdrom 

5. Browse the driver directory to obtain the path to the driver to be used in step 11.
Examples:
ls /cdrom/drivers/ultraport/openserver5
ls /cdrom/drivers/ultraport/openserver6

6. In the SCO OpenServer desktop, double click on the System Administration folder.
The System Administration window is now displayed.

7. In the System Administration window, double click on the software manager icon.
The Software Manager window is now displayed.

Note: The example above shows the directory name as /cdrom, You can either use this name 
or use another directory name to suit your requirements. For example, /mnt.
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8. In the Software Manager menu, click on Software > Install New.
The Begin Installation window is now displayed as shown in the next picture.

9. In the Begin Installation window, select the local host as the machine to install from by clicking 
on the From localhostname button and then click on Continue.
The Select Media window is now displayed.

10. In the Select Media window, using the Media Device selector choose the Media Images option 
then click on Continue.
The Enter Image Directory window is now displayed.

Click here to 
select the local 
host as the host 
machine. 
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11. In the Enter Image Directory window, enter the following in the Image directory field:
/cdrom/drivers/openserver5 - for SCO OpenServer 5.
/cdrom/drivers/openserver6 - for SCO OpenServer 6.  

12. In the Enter Image Directory window, click on OK.
The Install Selection window is now displayed.

Note: The example and picture above show a directory name including /cdrom, You can either 
include this name in the path or use another directory name to suit your requirements. 
For example, /mnt.
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13. In the Install Selection window, click on the Install button.
The following progress message is now displayed.

The above window will display various progress messages and then the Speed Installation 
Options window will be displayed.

14. If required, in the Speed Installation Options window, select the Re-Link kernel option.

15. In the Speed Window Installation menu, click on Options > Exit to close the window and 
continue the installation process.
If you select Re-link kernel, a message window is displayed at the end of the driver installation 
prompting you to re-boot the system.

16. In the message window click on OK to continue the installation process.
The following message is now displayed upon completion of the installation process.

Note: If you are installing more then one driver, you can de-select this option until you have 
installed all the drivers and utilities you require to save time.
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17. In the message window, click on OK to close the window.
The software manager window is now updated to show the driver you have installed as shown in 
the next picture.

18. In the Software Manager window, click on the Host > Exit menu option to close the window.
19. Shut down your system and turn the power off.
You can now continue with the rest of the installation process see General installation procedure 
for SCO OpenServer on page 62.

Serial port naming conventions
Each serial port has three device nodes associated with it. Each node takes the form of a file which 
you can access from operating system utilities and user applications. Details of these nodes are shown 
in the next table.

Device name Function Description Location

ttyz1 Normal communications port 
for local “tty” devices.

Indicates normal 
communications port behavior.

/dev

ttyZ1 Modem port Indicates that an open on a port 
will not complete unless DCD 
is present

/dev

ttyz1p Transparent printer port. Indicates that device should 
only be used for transparent 
printing.

/dev
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Configuring serial ports

The Port Configuration utility allows you to configure the SPEED serial ports you have installed on 
your system. To do this proceed as follows:

Starting the Port Configuration Utility
1. In the command prompt, type spdpcfg and press the Enter key. Alternatively use the SCO 

OpenServer desktop as follows:
a. In the SCO OpenServer desktop, open the System Administration folder.

The System Administration window is now displayed.
b. In the System Administration window, click on the Perle Speed folder on OpenServer 5 or 

Perle-Serial folder for OpenServer 6 to open it.
The Speed window is now displayed.

c. In the Speed window, click on the Speed Port Configuration Icon.
The Port Configuration window is now displayed as shown in the next picture.

Note: If you want to perform transparent printing from any of the terminals attached to your system, you 
need to check the contents of the printcap.spd file to see if the terminal type you are using is 
supported. To do this proceed as follows:
1. Using a text editor, go to the /etc directory and open the file called printcap.spd
2. Check the contents of the printcap.spd file to see if the terminal type you are using is 

supported. See page 113 in Appendix A: Transparent Printing for the syntax of the 
entries in this file.

3. If the terminal type you are using is not supported, add an entry for the new terminal 
type (including the type, transparent print ON and transparent print OFF strings) to the 
printcap.spd file (page 115). See the user guide for your terminal for details of the 
entries required.

You can now configure the ports you want using the Port Configuration utility.
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Menu map
The Port Configuration tool menu is as follows 
:

Menu option Description

Ports > Quit Quit Port Configuration tool without saving 
changes.

Logins Display all ports with logins enabled.

Unconfigured Display all ports without logins enabled.

All Display all ports.

Save & Exit Exit the Port Configuration tool and save 
changes.

Menus see 
page 69.

Select a getty 
definition 
here.  
See page 70.

Select a 
terminal type 
here. 
See page 71

Select one or 
more ports 
from this list.

Enables or 
disables flow 
control. 
See page 71Enables or 

disables login. 
See page 71
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Selecting Ports
2. In the Port Configuration window, select the ports you want you want to configure by clicking on 

one or more items in the list of ports (example in next picture).

Selecting a getty definition
3. In the Port Configuration window, select the getty definition you want by double clicking on an 

item in the Available gettydefs list. Alternatively, click on the Set button.

The list of currently selected ports is now updated to show the new getty definition.

Note: To select multiple items which follow each other in the list, hold down the Shift key and 
click on all the items you want.
To select multiple items from anywhere in the list, hold down the Ctrl key and click on 
all the items you want.

New definition 
displayed here
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Selecting terminal type
4. In the Terminal type list, double click on the terminal type you want for the currently selected 

ports. Alternatively, single click on the item you want in the Terminal type list and press the Set 
button.
The list of ports is now updated to show the new terminal type.

Enabling and disabling flow control
5. If required, in the Port Configuration window, click on the ixon button to enable flow control for 

Transparent printing. 

6. If required, in the Port Configuration window, click on the ixany button to enable sending of data 
on receipt of the next character (when flow control is enabled on the transparent print port).

Setting up a port login
7. In the Port Configuration window, click on one of the menu options shown in the next table to 

display the ports with the login status you want to change. For example, ports without logins 
enabled. 
These options allow you to filter on the type of ports you are looking for. This facility is helpful 
when you have a large number of ports installed.

Note: or information about transparent printing, see Appendix A: Transparent Printing.

To Display Click menu option

All ports with logins enabled Ports > Logins

All ports without logins enabled Ports > Unconfigured

Display all ports Ports > All

New terminal type 
displayed here
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8. If required, in the Port Configuration window, select the ports whose logins status you want to 
change, then click on one of the following to change the login status:

The selected ports in the list now are updated show their new login status. For example if you 
enable the login for a port, a tick is displayed along side the port as shown in the next picture.

9. Repeat steps 2. to 8. until you have configured all the ports you want.

Exiting the Port Configuration tool
10. In the Port Configuration menu, click on Ports > Save & Exit.

The Port Configuration tool now closes and saves any changes you have made.

To Click on

Enable logins for a port Enable button

Disable logins for a port Disable button

Note: To quit the Port Configuration tool without saving changes,
In the Port Configuration menu, click on Ports > Quit.
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Setultrap Interface Protocol Configuration Utility  
(UltraPort SI only)

Perle provides a command line utility that allows the user to configure each UltraPort SI serial ports 
for features EIA-232, EIA-422, EIA-485 full duplex and EIA-485 half duplex.

Command Line Interface
setultrap -f device_name -l
setultrap -f device_name -x baud-multiplier
setultrap -f device_name -m 232 [-s fast|slow]
setultrap -f device_name -m 422 [-s fast|slow] [-t term|unterm]
setultrap -f device_name -m 485fdx [-s fast|slow] [-t term|unterm] [-a auto|rts] 

[-b 0-15]
setultrap -f device_name -m 485hdx [-s fast|slow] [-t term|unterm]  

[-e echoon|echooff] [-a auto|rts] [-b 0-15]
-l list protocol configuration for serial device(s)
-x set baudrate multiplier for serial devices(s)
-m set interface protocol for serial device(s)

:

Note: The default interface protocol for the Perle UltraPort SI cards is EIA-232.

Option description
Configuration 
option 232 422 485hdx 485fdx

specifies the port to apply 
the configuration option to 

-f required required required required

Lists the serial ports 
configuration

-l optional optional optional optional

Interface mode -m default
232

optional
422

optional
485hdx

optional
485fdx

Baud rate multiplier -x optional
(1,2,4,8,
16,32)

optional
(1,2,4,8,
16,32)

optional
(1,2,4,8,
16,32)

optional
(1,2,4,8,
16,32)

Slew rate limiting -s optional
fast/slow

optional
fast/slow

optional
fast/slow

optional
fast/slow

Line termination -t N/A optional
term/unterm

optional
term/unterm

optional
term/unterm

EIA-485 HDX local echo -e N/A N/A optional
echoon/echoff

N/A

EIA-485 TX Driver 
Control

-a N/A N/A optional
auto/rts

optional
auto/rts

Auto EIA-485 bit delay -b N/A N/A optional
(0 -15)

optional
(0 -15)
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-f Specifies the port the action should be taken on. 
/dev/ttyz1 - specifies port 1 
/dev/ttyz1,/dev/ttyz64 -specifies port 1 through port 64 (ranges are separated by a 
comma)

-l Lists protocol configuration for each serial port configured on the UltraPort SI. 
/dev/ttyz1 232 slow term 1 
/dev/ttyz1 485fdx fast term auto 5 1 
The first example shows a device named ttyz1 configured for protocol mode EIA-232, slew rate 
limiting is set to slow, termination is on, and the baud rate multiplier is 1  
The second example shows device named ttyz1 configured for protocol mode EIA-485fdx, 
slew rate limiting is set to fast, termination is on, EIA-485 HDX TX Driver Control is set to 
auto with bit delay of 5 bits and the baud rate multiplier is 1

- m Interface mode: The valid software switchable protocol types are EIA-232, EIA-422, EIA-485 
Full Duplex and EIA-485 Half Duplex. Each port on the UltraPort SI are independent of each 
other and therefore you may select different protocols per serial port.

-x Baud Rate multiplier: The baud rate multiplier allows the user to multiply the configured 
baud rate by 1, 2, 4, 8,16 or 32, hence achieving greater speeds on the UltraPort SI serial 
interfaces. This is applicable for each protocol type selected. Baud rates for EIA-232 are up to 
921.6 Kbps per serial port. Baud rates for EIA-422/EIA-485 are up to 3.686 Mbps per serial 
port.

-s Slew Rate Limiting: The default setting for slew rate limiting is disabled. This will allow 
higher baud rate speeds on each EIA interface port. Slew rate limiting enabled, minimizes EMI 
and reduces reflections caused by improperly terminated cables. Operation in slew rate limited 
mode reduces the amplitudes of high-frequency harmonics.

-t Line Termination: The line termination parameter is not changeable by the user in EIA-232 
mode. However both EIA-422 and EIA-485 modes are defaulted to disabled but can be enabled 
by the user if needed.

-e EIA-485 HDX Local Echo: Local echo by default is on. This parameter applies only to EIA-
485 half duplex mode. All characters will be echoed to the user and transmitted across the serial 
ports. Some EIA-485 applications require local echo to be enable in order to monitor the 
loopback data to determine that line contention has occurred. If your application cannot handle 
loopback data the local echo should be disabled.

-a EIA-485 TX Driver Control: The default for this field is AUTO. When Auto is set the 
UltraPort SI will automatically detect the beginning and the ending of data being transmitted in 
order to enable and disable the transmit line. When the field is set to RTS it is the host 
application’s responsibility to enable and disable the transmit line via the RTS handshake line 
when it wants to send data. 

-b Auto EIA-485 Bit Delay: By default this field is set to 0 delay. This field is only applicable if 
you have configured EIA-485 TX Driver Control to AUTO. Values for this field are 0 through 
15 bits.

-h  Help: Displays the setultrap usage screen
.

Note: The port must be closed and then opened for the new parameters to take effect.
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Examples
The following examples show typical user applications.
Example 1: List options configured for serial port 1 through 16:

etc/setultrap -f /dev/ttyz0,/dev/ttyz15 -l 

Example 2: Set serial port 1 through 16 to interface type EIA-422
etc/setultrap -f /dev/ttyz0,/dev/ttyz15 -m 422 

Example 3: Configure ports 1 to 4 to EIA-485 full duplex
etc/setultrap -f /dev/ttyz0,/dev/ttyz3 -m 485fdx 

Example 4: Set serial port ttyPS1 to EIA-485 half duplex termination enabled, control bit-delay 5
etc/setultrap -f /dev/ttyz1 -m 485hdx -t term -b 5 

These commands may be added to a startup script to cause them to run automatically whenever the 
system is started. A sample commented out startup script is (/etc/init.d/rc.setultrap) supplied with this 
driver.
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Removing drivers and utilities from your system
To remove the SPEED device drivers and utilities for the SCO OpenServer operating system proceed 
as follows:
1. In the SCO OpenServer desktop, double click on the System Administration folder.

The System Administration window is now displayed.
2. In the System Administration window, double click on the software manager icon.

The Software Manager window is now displayed.

3. In the Software Manager window select the driver you want to remove.
4. In the Software Manager menu, click on Software > Remove software.

A confirmation window is now displayed prompting you to confirm removal.
5. In the confirmation window, click on the Remove button.

The software is now removed and the following Kernel re-link message is now displayed as 
shown in the next picture (not displayed under SCO OpenServer 6).

The Kernel re-link message window now closes and the removal continues. A message is 
displayed upon completion.

6. In the message window, click on OK to close the window.
The software manager window is now updated to show the remaining software.
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Installing under SCO UnixWare
General installation procedure for SCO UnixWare

The general procedure for installing and configuring host cards, drivers software and associated 
utilities for the SCO UnixWare operating system is as follows:
1. Install any UltraPort cards you require into your system. See Installing/Removing Host Cards 

And Cable Accessories on page 10 

2. If required, install the SPEED SCO UnixWare drivers and utilities onto your system using the 
procedures described in Installing drivers and utilities on page 78.

3. If required, remove any host cards you want from your system. See Installing/Removing Host 
Cards And Cable Accessories on page 10.

4. Using the Serial Manager utility, configure the serial ports you have added to the system. See 
Configuring serial ports on page 80.

Your system can now use the serial adaptor cards you have installed. If required, you can reconfigure 
serial ports following initial installation. 

Note: Once you have installed the SPEED drivers, if you add or remove any host cards the 
operating system will update the kernel accordingly using the spdconf program. 
spdconf is run automatically during boot up and checks to see if any host cards have 
been added or removed since the last time the system was powered up. If anything has 
changed the files which identify the ports, terminals and transparent printing are 
updated.
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Installing drivers and utilities
To install the SPEED device drivers and utilities for the SCO UnixWare operating system proceed as 
follows:
1. Login to your system as root.
2. Load the CDROM into your system CD drive.
3. Mount the CDROM to a mount point, for example /cdrom.
4. At the command prompt, type: 

pkgadd -d /cdrom/drivers/unixware/spd-uw-x.y.z.pkg spd 
- where x.y.z is the version number of the driver. 

5. Press the Enter key. 
The system now installs the driver and displays a series of messages ending with a successful 
installation message.

Upon installation of the drivers, your UltraPort cards are ready to use.

Note: A re-boot of your system is not necessary as the drivers for your UltraPort card are dynamically 
loadable and will be loaded as soon as any software attempts to access the associated devices
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Serial port naming conventions
Each serial port has three device nodes associated with it. Each node takes the form of a file which 
you can access from operating system utilities and user applications. Details of these nodes are shown 
in the next table.

Device name Function Description Location

z1 Normal communications port 
for local “tty” devices.

Indicates normal 
communications port behavior.

/dev/term

Z1 Modem port Indicates that an open on a port 
will not complete unless DCD 
is present

/dev/term

z1p Transparent printer port. Indicates that device should 
only be used for transparent 
printing.

/dev/term
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Configuring serial ports
The software provided with the SCO UnixWare operating system includes a utility called Serial 
Manager which allows you to configure the extra serial ports you have added to your system. 

To configure serial ports with Serial Manager proceed as follows:

1. At the command prompt, type scoadmin
The System Administration window is now displayed as shown in the next picture.

Note: On UnixWare 7.0, you must apply a patch file called ptf7053 before using the Serial 
Manager. You can find the patch on the SCO web site at:
http://www.sco.com 

Note: If you want to perform transparent printing from any of the terminals attached to your system, you 
need to check the contents of the printcap.spd file to see if the terminal type you are using is 
supported. To do this proceed as follows:
1. Using a text editor, go to the /etc directory and open the file called printcap.spd
2. Check the contents of the printcap.spd file to see if the terminal type you are using is 

supported. See page 113 in Appendix A: Transparent Printing for the syntax of the 
entries in this file.

3. If the terminal type you are using is not supported, add an entry for the new terminal 
type (including the type, transparent print ON and transparent print OFF strings) to the 
printcap.spd file (page 115). See the user guide for your terminal for details of the 
entries required.

4. If you have made any changes then type spdconf in order to re-configure the print port 
settings.

You can now configure the ports you want using the Serial Manager utility.
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2. In the System Administration tool window, click on the Hardware folder and then select Serial 
Manager
The Serial Manager window is now displayed showing the host cards (including SPEED) 
currently present on the system.

3. In the Serial Manager window, select the host card you want. Then in the Serial Manager menu, 
click on View > Ports.
The Serial Manager window now displays the ports available for the selected host card as shown 
in the next picture.
 81



Installing under SCO UnixWare
4. In the Serial Manager menu, click on Port-U > Modify.
The Modify Serial Port window is now displayed.

5. In the Modify Serial Port window, set the parameters shown in the next table

Parameter Set to

Port Type Select either Local Terminal or Modem

Configure port incoming only

Speed the speed value you require

Note: Because the system does not support the selection of speeds above 115200 bps, lower 
baud rates have been permanently remapped to support higher port speeds. Remapped 
speeds are shown in the next table. Therefore the lowest baud rate supported is 134 bps.

Selected speed (bps) Actual speed (bps)

50 230400

75 460800

110 921600
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6. In the Modify Serial Port window, click on the Port settings button.
The Port settings window is now displayed.

7. In the Port settings window, select the Data bits and Parity values you require and click on OK.
8. In the Modify Serial Port window, click on OK to accept the changes you have made and close 

the window.
9. Repeat steps 3. to 8. until you have configured the serial ports for all the host cards you require.
10. In the Serial Manager menu click on Host > Quit to quit Serial Manager and close the window.
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Setultrap Interface Protocol Configuration Utility 
(UltraPort SI only)

Perle provides a command line utility that allows the user to configure each UltraPort SI serial ports 
for features EIA-232, EIA-422, EIA-485 full duplex and EIA-485 half duplex.

Command Line Interface
setultrap -f device_name -l

setultrap -f device_name -x baud-multiplier

setultrap -f device_name -m 232 [-s fast|slow]

setultrap -f device_name -m 422 [-s fast|slow] [-t term|unterm]

setultrap -f device_name -m 485fdx [-s fast|slow] [-t term|unterm] [-a auto|rts] 
[-b 0-15]

setultrap -f device_name -m 485hdx [-s fast|slow] [-t term|unterm]  
[-e echoon|echooff] [-a auto|rts] [-b 0-15]

-l list protocol configuration for serial device(s)

-x set baudrate multiplier for serial devices(s)

-m set interface protocol for serial device(s)
:

Note: The default interface protocol for the Perle UltraPort SI cards is EIA-232.

Option description
Configuration 
option 232 422 485hdx 485fdx

specifies the port to apply 
the configuration option to 

-f required required required required

Lists the serial ports 
configuration

-l optional optional optional optional

Interface mode -m default
232

optional
422

optional
485hdx

optional
485fdx

Baud rate multiplier -x optional
(1,2,4,8,
16,32)

optional
(1,2,4,8,
16,32)

optional
(1,2,4,8,
16,32)

optional
(1,2,4,8,
16,32)

Slew rate limiting -s optional
fast/slow

optional
fast/slow

optional
fast/slow

optional
fast/slow

Line termination -t N/A optional
term/unterm

optional
term/unterm

optional
term/unterm

EIA-485 HDX local echo -e N/A N/A optional
echoon/echoff

N/A

EIA-485 TX Driver 
Control

-a N/A N/A optional
auto/rts

optional
auto/rts

Auto EIA-485 bit delay -b N/A N/A optional
(0 -15)

optional
(0 -15)
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-f Specifies the port the action should be taken on. 
/dev/ttyz1 - specifies port 1 
/dev/ttyz1,/dev/ttyz64 -specifies port 1 through port 64 (ranges are separated by a 
comma)

-l Lists protocol configuration for each serial port configured on the UltraPort SI. 
/dev/ttyz1 232 slow term 1 
/dev/ttyz1 485fdx fast term auto 5 1 
The first example shows a device named ttyz1 configured for protocol mode EIA-232, slew rate 
limiting is set to slow, termination is on, and the baud rate multiplier is 1  
The second example shows device named ttyz1 configured for protocol mode EIA-485fdx, 
slew rate limiting is set to fast, termination is on, EIA-485 HDX TX Driver Control is set to 
auto with bit delay of 5 bits and the baud rate multiplier is 1

- m Interface mode: The valid software switchable protocol types are EIA-232, EIA-422, EIA-485 
Full Duplex and EIA-485 Half Duplex. Each port on the UltraPort SI are independent of each 
other and therefore you may select different protocols per serial port.

-x Baud Rate multiplier: The baud rate multiplier allows the user to multiply the configured 
baud rate by 1, 2, 4, 8,16 or 32, hence achieving greater speeds on the UltraPort SI serial 
interfaces. This is applicable for each protocol type selected. Baud rates for EIA-232 are up to 
921.6 Kbps per serial port. Baud rates for EIA-422/EIA-485 are up to 3.686 Mbps per serial 
port.

-s Slew Rate Limiting: The default setting for slew rate limiting is disabled. This will allow 
higher baud rate speeds on each EIA interface port. Slew rate limiting enabled, minimizes EMI 
and reduces reflections caused by improperly terminated cables. Operation in slew rate limited 
mode reduces the amplitudes of high-frequency harmonics.

-t Line Termination: The line termination parameter is not changeable by the user in EIA-232 
mode. However both EIA-422 and EIA-485 modes are defaulted to disabled but can be enabled 
by the user if needed.

-e EIA-485 HDX Local Echo: Local echo by default is on. This parameter applies only to EIA-
485 half duplex mode. All characters will be echoed to the user and transmitted across the serial 
ports. Some EIA-485 applications require local echo to be enable in order to monitor the 
loopback data to determine that line contention has occurred. If your application cannot handle 
loopback data the local echo should be disabled.

-a EIA-485 TX Driver Control: The default for this field is AUTO. When Auto is set the 
UltraPort SI will automatically detect the beginning and the ending of data being transmitted in 
order to enable and disable the transmit line. When the field is set to RTS it is the host 
application’s responsibility to enable and disable the transmit line via the RTS handshake line 
when it wants to send data. 

-b Auto EIA-485 Bit Delay: By default this field is set to 0 delay. This field is only applicable if 
you have configured EIA-485 TX Driver Control to AUTO. Values for this field are 0 through 
15 bits.

-h  Help: Displays the setultrap usage screen
.

Note: The port must be closed and then opened for the new parameters to take effect.
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Examples
The following examples show typical user applications.
Example 1: List options configured for serial port 1 through 16:

etc/setultrap -f /dev/ttyz0,/dev/ttyz15 -l 

Example 2: Set serial port 1 through 16 to interface type EIA-422
etc/setultrap -f /dev/ttyz0,/dev/ttyz15 -m 422 

Example 3: Configure ports 1 to 4 to EIA-485 full duplex
etc/setultrap -f /dev/ttyz0,/dev/ttyz3 -m 485fdx 

Example 4: Set serial port ttyPS1 to EIA-485 half duplex termination enabled, control bit-delay 5
etc/setultrap -f /dev/ttyz1 -m 485hdx -t term -b 5 

These commands may be added to a startup script to cause them to run automatically whenever the 
system is started. A sample commented out startup script is (/etc/init.d/rc.setultrap) supplied with this 
driver.

Removing drivers and utilities from your system
To remove the software drivers from your system under the SCO UnixWare operating system proceed 
as follows:
1. At the command prompt, type pkgrm spd and press Enter 
The SPEED driver and associated utilities are now removed from your system.
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Introduction

You need to read this chapter if you want cabling information for the Perle UltraPort and UltraPort SI 
and UltraPort Express serial adaptor cards.
This chapter provides cabling and connector pinout information for the Perle UltraPort serial adaptor 
cards. Included are details of standard cables for use with UltraPort, UltraPort SI and UltraPort 
Express products available from Perle.
This chapter includes the following sections:

Definitions of Signals and Direction on page 88
Host card back panel connectors and pinouts on page 89
Connector box and cable guide on page 100
Connector box and cable pinouts on page 101
Ultraport User Guide 87



Definitions of Signals and Direction
Definitions of Signals and Direction

EIA-232 EIA-422 EIA-485 Direction Description

RI In Ring Indicator

DCD In Data Carrier Detect

RTS Out Request To Send

RTS+ Out Request to Send

RTS- Out Request to Send

DSR In Data Set Ready

TXD Out Transmit Data

TXD+ Out Transmit Data

TXD- Out Transmit Data

TXD-/RXD- In/Out Transmit/Receive Data

TXD+/RXD+ In/Out Transmit/Receive Data

RXD In Receive Data

RXD+ RXD+ In Receive Data

RXD- RXD- In Receive Data

S-GND S-GND S-GND Signal Ground

CTS In Clear to Send

CTS+ In Clear to Send

CTS- In Clear to Send

DTR Out Data Terminal Ready

C-GND C-GND C-GND Chassis Ground

Note: Only the UltraPort SI series of cards supports EIA-422 and EIA-485 interface modes.
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Host card back panel connectors and pinouts

This section contains diagrams and pinout information for the UltraPort host card back panel 
connectors contains the following:

DB9 back panel connectors and pinout on page 90
RJ45 back panel connectors and pinout on page 91
VHDCI-68 Ultra SCSI back panel connectors and pinout on page 93
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Host card back panel connectors and pinouts
DB9 back panel connectors and pinout
The following diagram shows the UltraPort2/UltraPort2 SI/UltraPort2 Express, UltraPort 
1/UltraPort1 SI/UltraPort1 Express, the UltraPort1 SI Low Profile and UltraPort1 Express back 
panels respectively. 

DB9M pin EIA-232 EIA-422 EIA-485

1 DCD CTS- NC

2 RXD RXD+ RXD+

3 TXD TXD- TXD-/RXD-

4 DTR TXD+ TXD+/RXD+

5 S-GND S-GND S-GND

6 DSR RXD- RXD-

7 RTS RTS- NC

8 CTS CTS+ NC

9 RI RTS+ NC

Shell C-GND C-GND C-GND
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RJ45 back panel connectors and pinout
The following diagram shows the UltraPort4 and UltraPort4 Express cards back panel.

The connector pinout for each RJ45 socket fitted to the UltraPort4 and UltraPort4 Express cards are 
as follows:

RJ45 10-pin RJ45 8-pin EIA-232

1 N/A RI

2 1 DCD

3 2 RTS

4 3 DSR

5 4 TXD

6 5 RXD

7 6 S-GND

8 7 CTS

9 8 DTR

10 N/A

Shell Shell C-GND
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RJ12 back panel connectors and pinout
The following diagram shows the UltraPort8i card back panel:

The connector pinout for each RJ12 socket fitted to the UltraPort8i and card is as follows:

RJ12 pin EIA-232

1 DCD

2 RXD

3 DTR or RTS

4 S-GND

5 TXD

6 CTS

Shell C-GND

Port 1

Pin 1
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VHDCI-68 Ultra SCSI back panel connectors and pinout
The following diagram shows the UltraPort4/UltraPort4 SI and UltraPort4/UltraPort4 SI Low Profile 
and UltraPort4 Express HD back panels respectively.

The connector pinout for each VHDCI-68 Ultra SCSI connector fitted to the UltraPort4, UltraPort4 
SI, and UltraPort4 Express HD is as follows:

Note: The UltraPort fan-out cables need to be secured or supported in case of sudden contact 
or excessive weight on the cables. Please ensure that adequate caution is taken to avoid 
possible damage to the UltraPort card or Host system. This can be accomplished by 
securing the cables to a rack or to the back of the server.

VHDCI-68 
Ultra SCSI 
Pin Number EIA-232 EIA-422 EIA-485

1 RXD4 RXD4+ RXD4+

2 CTS4 CTS4+ NC

3 RI4 RTS4+ NC

4 RTS4 RTS4- NC

5 DCD4 CTS4- NC

6 DTR4 TXD4+ TXD4+/RXD4+

7 DSR4 RXD4- RXD4-

8 TXD4 TXD4- TXD4-/RXD4-

9 S-GND S-GND S-GND
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10 TXD3 TXD3- TXD3-/RXD3-

11 DSR3 RXD3- RXD3-

12 DTR3 TXD3+ TXD3+/RXD3+

13 DCD3 CTS3- NC

14 RTS3 RTS3- NC

15 RI3 RTS3+ NC

16 CTS3 CTS3+ NC

17 RXD3 RXD3+ RXD3+

18 RXD2 RXD2+ RXD2+

19 CTS2 CTS2+ NC

20 RI2 RTS2+ NC

21 RTS2 RTS2- NC

22 DCD2 CTS2- NC

23 DTR2 TXD2+ TXD2+/RXD2+

24 DSR2 RXD2- RXD2-

25 TXD2 TXD2- TXD2-/RXD2-

26 S-GND S-GND S-GND

27 TXD1 TXD1- TXD1-/RXD1-

28 DSR1 RXD1- RXD1-

29 DTR1 TXD1+ TXD1+/RXD1+

30 DCD1 CTS1- NC

31 RTS1 RTS1- NC

32 RI1 RTS1+ NC

33 CTS1 CTS1+ NC

34 RXD1 RXD1+ RXD1+

35-42 NC NC NC

43 S-GND S-GND S-GND

44-59 NC NC NC

60 S-GND S-GND S-GND

61-68 NC NC NC

VHDCI-68 
Ultra SCSI 
Pin Number EIA-232 EIA-422 EIA-485
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The following diagram shows the UltraPort8 (old standard height PCI PCB board), 
UltraPort16/UltraPort16 SI, UltraPort8/UltraPort8 SI, and UltraPort8 Express Low profile back 
panels respectively

The connector pinout for each VHDCI-68 Ultra SCSI connector fitted to the UltraPort8 (old standard 
height PCI PCB board), UltraPort16/UltraPort16 SI, UltraPort8/UltraPort8 SI, and UltraPort8 
Express HD Low profile are as follows:
Ports 1-8 of VHDCI-68 Connector for UltraPort8, UltraPort8 SI, UltraPort8 Express HD, 
UltraPort16, and UltraPort16 SI adapter cards

Note: The UltraPort fan-out cables need to be secured or supported in case of sudden contact or 
excessive weight on the cables. Please ensure that adequate caution is taken to avoid possible 
damage to the UltraPort card or Host system. This can be accomplished by securing the 
cables to a rack or to the back of the server.

VHDCI-68 Ultra 
SCSI Pin 
Number EIA-232 EIA-422 EIA-485

1 RXD7 RXD7+ RXD7+

2 CTS7 CTS7+ NC

3 RI7 RTS7+ NC

4 RTS7 RTS7- NC

5 DCD7 CTS7- NC

6 DTR7 TXD7+ TXD7+/RXD7+

7 DSR7 RXD7- RXD7-

8 TXD7 TXD7- TXD7-//RXD7-

9 S-GND S-GND S-GND

10 TXD5 TXD5- TXD5-/RXD5-

11 DSR5 RXD5- RXD5-
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12 DTR5 TXD5+ TXD5+/RXD5+

13 DCD5 CTS5- NC

14 RTS5 RTS5- NC

15 RI5 RTS5+ NC

16 CTS5 CTS5+ NC

17 RXD5 RXD5+ RXD5+

18 RXD3 RXD3+ RXD3+

19 CTS3 CTS3+ NC

20 RI3 RTS3+ NC

21 RTS3 RTS3- NC

22 DCD3 CTS3- NC

23 DTR3 TXD3+ TXD3+/RXD3+

24 DSR3 RXD3- RXD3-

25 TXD3 TXD3- TXD3-//RXD3-

26 S-GND S-GND S-GND

27 TXD1 TXD1- TXD1-/RXD1-

28 DSR1 RXD1- RXD1-

29 DTR1 TXD1+ TXD1+/RXD1+

30 DCD1 CTS1- NC

31 RTS1 RTS1- NC

32 RI1 RTS1+ NC

33 CTS1 CTS1+ NC

34 RXD1 RXD1+ RXD1+

35 RXD8 RXD8+ RXD8+

36 CTS8 CTS8+ NC

37 RI8 RTS8+ NC

38 RTS8 RTS8- NC

39 DCD8 CTS8- NC

40 DTR8 TXD8+ TXD8+/RXD8+

41 DSR8 RXD8- RXD8-

42 TXD8 TXD8- TXD8-//RXD8-

43 S-GND S-GND S-GND

44 TXD6 TXD6- TXD6-/RXD6-

45 DSR6 RXD6- RXD6-

VHDCI-68 Ultra 
SCSI Pin 
Number EIA-232 EIA-422 EIA-485
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Ports 9-16 of second VHDCI-68 Connector for UltraPort16 and UltraPort16 SI cards

46 DTR6 TXD6+ TXD6+/RXD6+

47 DCD6 CTS6- NC

48 RTS6 RTS6- NC

49 RI6 RTS6+ NC

50 CTS6 CTS6+ NC

51 RXD6 RXD6+ RXD6+

52 RXD4 RXD4+ RXD4+

53 CTS4 CTS4+ NC

54 RI4 RTS4+ NC

55 RTS4 RTS4- NC

56 DCD4 CTS4- NC

57 DTR4 TXD4+ TXD4+/RXD4+

58 DSR4 RXD4- RXD4-

59 TXD4 TXD4- TXD4-//RXD4-

60 S-GND S-GND S-GND

61 TXD2 TXD2- TXD2-/RXD2-

62 DSR2 RXD2- RXD2-

63 DTR2 TXD2+ TXD2+/RXD2+

64 DCD2 CTS2- NC

65 RTS2 RTS2- NC

66 RI2 RTS2+ NC

67 CTS2 CTS2+ NC

68 RXD2 RXD2+ RXD2+

VHDCI-68 Ultra 
SCSI Pin 
Number EIA-232 EIA-422 EIA-485

1 RXD15 RXD15+ RXD15+

2 CTS15 CTS15+ NC

3 RI15 RTS15+ NC

4 RTS15 RTS15- NC

5 DCD15 CTS15- NC

6 DTR15 TXD15+ TXD15+/RXD15+

VHDCI-68 Ultra 
SCSI Pin 
Number EIA-232 EIA-422 EIA-485
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7 DSR15 RXD15- RXD15-

8 TXD15 TXD15- TXD15-//RXD15-

9 S-GND S-GND S-GND

10 TXD13 TXD13- TXD13-/RXD13-

11 DSR13 RXD13- RXD13-

12 DTR13 TXD13+ TXD13+/RXD13+

13 DCD13 CTS13- NC

14 RTS13 RTS13- NC

15 RI13 RTS13+ NC

16 CTS13 CTS13+ NC

17 RXD13 RXD13+ RXD13+

18 RXD11 RXD11+ RXD11+

19 CTS11 CTS11+ NC

20 RI11 RTS11+ NC

21 RTS11 RTS11- NC

22 DCD11 CTS11- NC

23 DTR11 TXD11+ TXD11+/RXD11+

24 DSR11 RXD11- RXD11-

25 TXD11 TXD11- TXD11-//RXD11-

26 S-GND S-GND S-GND

27 TXD9 TXD9- TXD9-/RXD9-

28 DSR9 RXD9- RXD9-

29 DTR9 TXD9+ TXD9+/RXD9+

30 DCD9 CTS9- NC

31 RTS9 RTS9- NC

32 RI9 RTS9+ NC

33 CTS9 CTS9+ NC

34 RXD9 RXD9+ RXD9+

35 RXD16 RXD16+ RXD16+

36 CTS16 CTS16+ NC

37 RI16 RTS16+ NC

38 RTS16 RTS16- NC

39 DCD16 CTS16- NC

40 DTR16 TXD16+ TXD16+/RXD16+

VHDCI-68 Ultra 
SCSI Pin 
Number EIA-232 EIA-422 EIA-485
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41 DSR16 RXD16- RXD16-

42 TXD16 TXD16- TXD16-//RXD16-

43 S-GND S-GND S-GND

44 TXD14 TXD14- TXD14-/RXD14-

45 DSR14 RXD14- RXD14-

46 DTR14 TXD14+ TXD14+/RXD14+

47 DCD14 CTS14- NC

48 RTS14 RTS14- NC

49 RI14 RTS14+ NC

50 CTS14 CTS14+ NC

51 RXD14 RXD14+ RXD14+

52 RXD12 RXD12+ RXD12+

53 CTS12 CTS12+ NC

54 RI12 RTS12+ NC

55 RTS12 RTS12- NC

56 DCD12 CTS12- NC

57 DTR12 TXD12+ TXD12+/RXD12+

58 DSR12 RXD12- RXD12-

59 TXD12 TXD12- TXD12-//RXD12-

60 S-GND S-GND S-GND

61 TXD10 TXD10- TXD10-/RXD10-

62 DSR10 RXD10- RXD10-

63 DTR10 TXD10+ TXD10+/RXD10+

64 DCD10 CTS10- NC

65 RTS10 RTS10- NC

66 RI10 RTS10+ NC

67 CTS10 CTS10+ NC

68 RXD10 RXD10+ RXD10+

VHDCI-68 Ultra 
SCSI Pin 
Number EIA-232 EIA-422 EIA-485
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Connector box and cable guide
The connector pinout information for the UltraPort product you are using depends on the number of 
ports and type of connector box or cable used as detailed in the next table:

Product
Card edge 
connector

Cable or connector box 
options

For connector 
pinouts see...

UltraPort4
UltraPort4 Express

RJ45 10-pin RJ45 - DB25M Converter See page 102

RJ45 - DB25F Converter See page 102

RJ45 - DB9M Converter See page 103

RJ45 - DB9F Converter See page 103

RJ45 - Speed Converter See page 104

RJ45 - Digi Converter See page 105

RJ45 - Digi ALTPIN Converter See page 106

UltraPort 4-LP
UltraPort4 SI-LP
UltraPort Express 4 HD
UltraPort8
UltraPort8 SI-LP
Ultraport8 Express HD
UltraPort16
UltraPort16 SI

VHDCI-68 RJ45 Connector Box See page 107

DB25M Connector Box See page 108

DB25F Connector Box See page 108

DB9M Connector Box See page 109

DB25M Fan-out Cable See page 110

DB25F Fan-out Cable See page 110

DB9M Fan-out Cable See page 111

DB9F Fan-out Cable See page 111
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Connector box and cable pinouts
Connector box and cable pinouts
This section contains pinout information for the UltraPort product range connector box and cable 
accessories and contains the following:

RJ45 10-pin to DB25 converter on page 102
RJ45 10-pin to DB9 converter on page 103
RJ45 10-pin to RJ45 SPEED converter on page 104
RJ45 10-pin to RJ45 Digi converter on page 105
RJ45 10-pin to RJ45 Digi ALTPIN converter on page 106
RJ45 connector box on page 107
DB25 connector box on page 108
DB9 connector box on page 109
DB25 Fan-out cable on page 110
DB9 Fan-out cable on page 111

Note: For details of which cables to use with which product, see Connector box and cable guide 
on page 100.
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Connector box and cable pinouts
RJ45 10-pin to DB25 converter

RJ45 pin DB25 Pin EIA-232 EIA-422 EIA-485

1 22 RI RTS+ NC

2 8 DCD CTS- NC

3 4 RTS RTS- NC

4 6 DSR RXD- RXD-

5 2 TXD TXD- TXD-/RXD-

6 3 RXD RXD+ RXD+

7 7 S-GND S-GND S-GND

8 5 CTS CTS+ NC

9 20 DTR TXD+ TXD+/RXD+

10 N/C

1 & Shell 1 & Shell C-GND C-GND C-GNDl
 102



Connector box and cable pinouts
RJ45 10-pin to DB9 converter

RJ45 pin DB9 Pin EIA-232 EIA-422 EIA-485

1 9 RI RTS+ NC

2 1 DCD CTS- NC

3 7 RTS RTS- NC

4 6 DSR RXD- RXD-

5 3 TXD TXD- TXD-/RXD-

6 2 RXD RXD+ RXD+

7 5 S-GND S-GND S-GND

8 8 CTS CTS+ NC

9 4 DTR TXD+ TXD+/RXD+

10 N/C

Shell Shell C-GND C-GND C-GND
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Connector box and cable pinouts
RJ45 10-pin to RJ45 SPEED converter

RJ45 10-pin 
to card

RJ45 10-pin 
SPEED

RJ45 8-pin 
SPEED EIA-232

1 1 N/A RI

2 2 1 DCD

3 8 7 RTS

4 4 3 DSR

5 6 5 TXD

6 7 6 RXD

7 5 4 S-GND

8 9 8 CTS

9 3 2 DTR

10 10 N/A

Shell Shell Shell C-GND
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Connector box and cable pinouts
RJ45 10-pin to RJ45 Digi converter

RJ45 10-pin 
to card

RJ45 10-pin 
Digi

RJ45 8-pin 
Digi EIA-232

1 1 N/A RI

2 10 N/A DCD

3 3 2 RTS

4 2 1 DSR

5 5 4 TXD

6 6 5 RXD

7 7 6 S-GND

8 8 7 CTS

9 9 8 DTR

10 N/C N/A

Shell 4 & Shell 3 & Shell C-GND
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Connector box and cable pinouts
RJ45 10-pin to RJ45 Digi ALTPIN converter

RJ45 10-pin 
to card

RJ45 10-pin 
Digi ALTPIN

RJ45 8-pin 
Digi ALTPIN EIA-232

1 1 N/A RI

2 2 1 DCD

3 3 2 RTS

4 10 N/A DSR

5 5 4 TXD

6 6 5 RXD

7 7 6 S-GND

8 8 7 CTS

9 9 8 DTR

10 N/C N/A

Shell 4 & Shell 3 & Shell C-GND
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Connector box and cable pinouts
RJ45 connector box

Note: The UltraPort connector box cable needs to be secured or supported in case of sudden 
contact or excessive weight on the cables. Please ensure that adequate caution is taken to 
avoid possible damage to the UltraPort card or Host system. This can be accomplished by 
securing the cable to a rack or to the back of the server.

RJ45 10-pin RJ45 8-pin EIA-232 EIA-422 EIA-485

1 N/A RI RTS+ NC

2 1 DCD CTS- NC

3 2 RTS RTS- NC

4 3 DSR RXD- RXD-

5 4 TXD TXD- TXD-/RXD-

6 5 RXD RXD+ RXD+

7 6 S-GND S-GND S-GND

8 7 CTS CTS+ NC

9 8 DTR TXD+ TXD+/RXD+

10 N/A

Shell Shell C-GND C-GND C-GND

Connect peripheral 
cable here via RJ45 

Push fit onto card 
edge connector

RJ45 connector block
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Connector box and cable pinouts
DB25 connector box

Note: The UltraPort connector box cable needs to be secured or supported in case of sudden 
contact or excessive weight on the cables. Please ensure that adequate caution is taken to 
avoid possible damage to the UltraPort card or Host system. This can be accomplished by 
securing the cable to a rack or to the back of the server.

DB25 Pin EIA-232 EIA-422 EIA-485

1 & Shell C-GND C-GND C-GND

2 TXD TXD- TXD-/RXD-

3 RXD RXD+ RXD+

4 RTS RTS- NC

5 CTS CTS+ NC

6 DSR RXD- RXD-

7 S-GND S-GND S-GND

8 DCD CTS- NC

20 DTR TXD+ TXD+/RXD+

22 RI RTS+ NC
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Connector box and cable pinouts
DB9 connector box

Note: The UltraPort connector box cable needs to be secured or supported in case of sudden 
contact or excessive weight on the cables. Please ensure that adequate caution is taken to 
avoid possible damage to the UltraPort card or Host system. This can be accomplished by 
securing the cable to a rack or to the back of the server.

DB9 Pin EIA-232 EIA-422 EIA-485

1 DCD CTS- NC

2 RXD RXD+ RXD+

3 TXD TXD- TXD-/RXD-

4 DTR TXD+ TXD+/RXD+

5 S-GND S-GND S-GND

6 DSR RXD- RXD-

7 RTS RTS- NC

8 CTS CTS+ NC

9 RI RTS+ NC

Shell C-GND C-GND C-GND
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Connector box and cable pinouts
DB25 Fan-out cable

Note: The UltraPort fan-out cables need to be secured or supported in case of sudden contact or 
excessive weight on the cables. Please ensure that adequate caution is taken to avoid possible 
damage to the UltraPort card or Host system. This can be accomplished by securing the 
cables to a rack or to the back of the server.

DB25 Pin EIA-232 EIA-422 EIA-485

1 & Shell C-GND C-GND C-GND

2 TXD TXD- TXD-/RXD-

3 RXD RXD+ RXD+

4 RTS RTS- NC

5 CTS CTS+ NC

6 DSR RXD- RXD-

7 S-GND S-GND S-GND

8 DCD CTS- NC

20 DTR TXD+ TXD+/RXD+

22 RI RTS+ NC

Push fit onto card 
edge connector

Port numbers 
labelled on DB25 
connectors

Connect peripheral cable 
here
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Connector box and cable pinouts
DB9 Fan-out cable

Note: The UltraPort fan-out cables need to be secured or supported in case of sudden contact or 
excessive weight on the cables. Please ensure that adequate caution is taken to avoid possible 
damage to the UltraPort card or Host system. This can be accomplished by securing the 
cables to a rack or to the back of the server.

DB9 Pin EIA-232 EIA-422 EIA-485

1 DCD CTS- NC

2 RXD RXD+ RXD+

3 TXD TXD- TXD-/RXD-

4 DTR TXD+ TXD+/RXD+

5 S-GND S-GND S-GND

6 DSR RXD- RXD-

7 RTS RTS- NC

8 CTS CTS+ NC

9 RI RTS+ NC

Shell C-GND C-GND C-GND
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Transparent Printing Appendix A:A

Introduction

You need to read this appendix if you want background information on transparent printing.
This appendix gives an overview of the transparent printing feature offered for the OpenServer and 
Unixware operating systems. Included are details of configuration files associated with transparent 
printing.
This appendix includes the following sections:

What is transparent printing? on page 113
Problems with printer output on page 114
The printcap.spd configuration file on page 114
The print.spd configuration file on page 115
Ultraport User Guide 112



Introduction
What is transparent printing?
Most terminals have an auxiliary (AUX) port which can be connected to a serial printer. Data can 
then be output to the terminal or the printer via the same serial line. This is called transparent print 
(or xprint) and is designed for printing simple ASCII text. A separate xprint device node (ttyznp 
where n is device number) is created for each port. This device is enabled automatically if either the 
local or modem device is enabled for the port.

When a host card receives data addressed to the transparent print device it prefixes it with the 
transparent print mode ON string and appends it with the transparent mode OFF string. The ON and 
OFF strings for each terminal type available are defined by the printcap.spd file. See The 
printcap.spd configuration file on page 114 for more details.
When the host card receives data addressed to the transparent print device, it prefixes it with the 
Transparent Print Mode ON string and appends it with the Transparent Print Mode OFF string. 
Terminal I/O has absolute priority over printer output. Transparent print data will only be sent when 
there is a break in output to the terminal (for more than a tenth of a second)
For each port, the transparent printing parameters are controlled by an entry in the print.spd file 
found in the /etc/ directory on your system. The entry for each port includes definitions of the 
terminal type, transparent print throughput rate and device name. See The print.spd configuration 
file on page 115 for further details.

Serial communications 
port on terminal

Terminal
Auxiliary port 
on terminal

Printer

SPEED Port 
Configuration utility

print.spd file 

SPEED Device 
driver

UltraPort host 
card

SCO OpenServer 
operating system

 Computer system
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Introduction
Problems with printer output
When you use transparent printing you may obtain incorrect printer output due to the following 
reasons:
Graphics printers may misinterpret some characters output through transparent print. This problem is 
more likely if the terminal is in 7-bit mode, because 8-bit characters will not be printed.
Some terminals suppress the output of certain characters to their printer or AUX ports. Such 
terminals can prevent essential control characters from reaching the printer thus generating incorrect 
printer output. This occurrence is extremely unpredictable because of the large number of potential 
hardware configurations.

The printcap.spd configuration file
The printcap.spd file defines the transparent print ON and OFF strings for each terminal type 
available. When a host card receives data addressed to the transparent print device it prefixes it with 
the transparent print mode ON string and appends it with the transparent mode OFF string.

If you don’t configure a specific terminal type printcap.spd will use the default type which is 
“unknown”

ansi ^X ^T

Terminal type.

Transparent print ON string.

Transparent print OFF 
 114



Introduction
The print.spd configuration file
For each port, transparent printing is controlled by an entry in the print.spd file. The print.spd file is 
found in the /etc/ directory on your system. The entry for each port includes definitions of the 
terminal type, transparent print throughput rate, device name. The content of the print.spd file is 
normally controlled automatically by either the Port Configuration utility (SCO OpenServer). A 
sample entry from a typical print.spd file is shown in the next example.

100 unknown ttyz1 -ixany -ixon 

Maximum number of characters per second 
throughput for transparent printing

Device name

Terminal type of terminal to which your printer is 
attached defined in the printcap.spd file.

Enables flow control for Transparent printing.

Enables sending of data on receipt of the next character 
(when flow control is enabled on the transparent print port).
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422/EIA-485 Appendix BB
Introduction
The EIA-422 Standard on page 117
The EIA-485 Standard on page 118
Cabling Distances on page 122
Ultraport User Guide 116



The EIA-422 Standard
The EIA-422 Standard
The EIA-422 defines a standard for serial communications. EIA-422 is a high speed or long distance 
transmission method. EIA-422 system software differs little from familiar point to point EIA-232 
communication systems. EIA-422 is often used to extend the distance between nodes over the 
capabilities of EIA-232. When communicating at high data rates or over long distances in real world 
environments, single ended methods are often inadequate. Differential data transmission (balanced 
differential signal) offers superior performance in most applications. Differential signals can help 
nullify the effects of ground shifts and induced noise signals that appear as common mode voltages 
on a network. EIA-422 is also specified for multi-drop (party-line) applications where only one driver 
is connected to, and transmits on a ”bus” of up to 10 receivers. While a multi-drop “type” application 
has many advantages, EIA-422 devices cannot be used to construct a truly multi-point network. A 
true multi-point network consists of multiple drivers and receivers connected on a single bus, where 
any node can transmit and receive. However a “Quasi” multi-drop network using EIA-422 consisting 
of 4 wires can enable a single master in a system to send a command to one of several slave devices 
on a network. The master node simply prefixes the commands with the appropriate address of the 
slave. There is no data echo or turn around delays to consider. Since each of the slaves transmitters 
shares the same pair of wires, care should be taken that the master never requests data from multiple 
nodes at the same time or data collision can occur. 

Specifications EIA-422

Mode of operation. Differential

Total number of Drivers and 
receivers on one line

1 driver, 10 receivers

Maximum Driver Output 
Voltage

-0.25V to +6V

Driver Output signal loaded +/-2.0V

Driver Output signal unloaded +/-6V

Driver load Impedance (Ohms) 100

Slew Rate fast/slow

Receiver Input Voltage range -10V to + 10V

Receiver Input Sensitivity +/-200mV

Receiver Input Resistance 
(Ohms)

4k min.
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The EIA-485 Standard
The EIA-485 Standard
The EIA-485 standard is similar to the EIA-422 standard upon which it was based. The main 
difference is that up to 32 transmitter receiver pairs may be present on the line at one time. A 120-
Ohm resistor integrated on the UltraPort SI card should be enabled to terminate either end of the main 
line. The UltraPort SI when configured for EIA-485 full duplex is compatible to use in a EIA-422 
multi-drop environment. EIA-485 can be used in situations where more than one device may transmit 
data on a shared data line. In general not all lines are used for EIA-485 systems. In a two wire half 
duplex configuration the TXD+ line is connected to the RXD+ while the TDX- line is connected to 
the RXD-, only one pair of twisted wire cable is used in a EIA-485 half duplex communications 
configuration. The special circuitry in the UltraPort SI card when set to auto will automatically sense 
when data is being transmitted and automatically enable the transmit line as well as disable the 
transmit line when the data has been sent. Some EIA-485 applications use the RTS handshake line to 
enable and disable the transmit line. In this case then the field EIA-485 HDX TX Control should be 
set to RTS. It is now the host application’s responsibility to enable and disable the transmit line via 
the RTS handshake line when it wants to send data. When the EIA-485 HDX TX Control field is set 
to AUTO, the UltraPort SI card allows you to further customized your application by applying a Auto 
EIA-485 Bit Delay. This field by default is set to 0 delay, however in some applications the user may 
want to increase this field up to 15 bits.

Specifications EIA-485

Mode of operation. Differential

Total number of Drivers and 
receivers on one line

32 drivers or receivers

Maximum Driver Output Voltage -0.25V to +6V

Driver Output signal loaded +/-2.0V

Driver Output signal unloaded +/-6V

Driver load Impedance (Ohms) 100

Slew Rate fast/slow

Receiver Input Voltage range -10V to + 10V

HDX Control +/-200mV

Bit-delay 4k min.
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The EIA-485 Standard
Many Masters / Many Slaves
The EIA-485 Full Duplex mode supports many Masters and many Slaves. This system can be used 
when all EIA-485 devices have separate transmit and receive channels. There is no multiplexing of 
the TXD and RXD signals on the same device. This system is especially useful when there is no flow 
control available on the PC, usually due to the use of third party communications programs that 
prevents the use of the RTS signal as a “transmit enable” control. The advantages of this system are 
great, since no new communications software is needed, and the PC can talk and listen at the same 
time. In effect the handshaking is done by the intelligence of the UltraPort SI card.
As wired in the next diagram, the PC can transmit data at any time and the EIA-485 devices#1 to #n 
can simultaneously receive it. Only one of the EIA-485 devices may transmit data at any one time. 
Each EIA-485 device recognizes commands and data addressed to it and will only transmit when the 
Master PC commands it to do so. When the EIA-485 devices receives a command, the UltraPort SI 
card automatically turns its TXD drivers on and sends the data on the TXD channel, and then disables 
its TXD drivers afterwards. The other EIA-485 devices remain in the tri-state mode when they are not 
being addressed and do not transmit any data.
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The EIA-485 Standard
One Master / Many Slaves
The EIA-485 Half Duplex mode supports a Master and many Slaves devices. This system has only 
one master device which can transmit to multiple slave devices. In many cases there will be only one 
master device, which can transmit data and the other simply receives it.There is no multiplexing of 
the TXD and RXD lines. The data is flowing only in one direction and needs only one pair of wires.

EIA-485 Half Duplex Diagram #1

Note: Pin numbers provided in above diagrams are for UltraPort SI DB9 connectors
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The EIA-485 Standard
Another popular layout is for multiple masters and slaves in EIA-485 half duplex mode. This is also 
known as a party line transmission. It is imperative to have some method of preventing two devices 
from driving the line at the same time. The normal method is to use the RTS as a talk enable control. 
The RTS line will go true immediately prior to transmission and go false immediately after the last 
byte in the data stream is sent.

EIA-485 Half Duplex Diagram #2

Fail Safe Circuitry
Two common fault conditions that an EIA-485 system can experience are as follows:

The cable is open: This occurs when there are no drivers on the circuit. In a party line/multi 
driver/receiver system this is intentional. However there are unintentionally situations when the 
twisted pair line is accidentally cut/disconnected or the transmitting device fails. In EIA-485 half 
duplex multi-drop systems there are extended periods of time when none of the possible talkers 
are gated onto the bus. This is known as a idle state and occurs when all the driver outputs are in 
the high impedance state. The lines float perhaps being pulled to high or low which can be 
caused by noise or other voltages. The UltraPort SI cards contain Fail safe Open circuit detection 
which allows the receiver to go into a known, pre-determined state and prevents false start bits 
and bad data from being transmitted
The cable has a short: Short circuits are when the two lines of a twisted pair are connected 
together. This can occur due to a damaged or due to a failure of one or more 
transmitters/receivers on the line. The short condition on the line is dangerous in that damage to 
the receiver may occur and communications can be corrupted or disabled.The EIA-485 specifies 
that the input threshold of a receiver be between +/200mV differential. This basically means that 
if the differential voltage on a receiver is 0V, the output state is indeterminate. The Perle 
UltraPort SI design ensures that the receiver thresholds are between -50mV and -200mV. If 0V 
appears across the input stage due to a fault condition, the output is guaranteed to be a logic high.
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Cabling Distances
Cabling Distances

Cable length (in feet) Protocol Transfer Rate, Kbps

7 EIA-422/EIA-485 3686.4

1000 EIA-422/EIA-485 3686.4

2000 EIA-422/EIA-485 1843.2

3000 EIA-422/EIA-485 921.6

4000 EIA-422/EIA-485 921.6

7 EIA-232 19.2

1000 EIA-232 38.4

2000 EIA-232 19.2

3000 EIA-232 9.6

4000 EIA-232 9.6

Note: These tests were conducted in a controlled lab environment using shielded CAT 5 cabling
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Troubleshooting Appendix CC

Introduction

You need to read this appendix if you want information on troubleshooting problems with UltraPort, 
UltraPort SI, and UltraPort Express serial adaptor cards.
This appendix provides examples of normal boot up messages and a table of error messages, their 
meaning and corrective action required for the all the currently supported operating systems.
This appendix includes the following sections:

SCO OpenServer 5 on page 124.
SCO UnixWare/SCO OpenServer 6 on page 127
Microsoft Windows on page 130
Windows NT on page 131 (UltraPort and UltraPort SI only)
Ultraport User Guide 123



SCO OpenServer 5
SCO OpenServer 5
Example of normal SPEED driver boot messages

This example shows one UltraPort16 and one UltraPort8 successfully detected and initialized by the 
driver.

Driver software version

Total number of SPEED ports

Driver message - always displayed if installed and configured

IRQ level 

Host card typeHost card ID number

%SPD - - -  Perle Speed Driver:1.1.0.1
%SPD - 5 - unit:0 - UltraPort16 card - OK
%SPD - 10 - unit:1 - UltraPort8 card - OK
%SPD - - - Total Speed Ports : 24

%SPD - 5 - unit:1 - UltraPort8 card - OK
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SCO OpenServer 5
Additional card warning messages
If you install more than one UltraPort, UltraPort SI or UltraPort Express host card, or install 
additional cards at a later date, the following warning messages will be displayed (they appear 
immediately following the driver initialisation messages shown on  page 124).

Note: Display of these messages and update of Speed Node and Init files only occurs once after 
installation of additional cards. This takes place during system start-up.

Message This message tells you that...

WARNING: Speed Node file updated 
- old file moved to /etc/conf/node.d/spd_nnnnnnnn

The speed node file has been updated to 
include the revised number of ports.
Your old Speed node file is retained with the 
file name shown in the message. 'nnnnnnnn' 
is a unique number so that previous Speed 
node files are not lost on updating.

WARNING: New Speed ports detected 
- /etc/conf/node.d/spd being updated

You now have additional entries in the Speed 
init file, existing entries are retained 
unchanged. The automatic init file update is 
necessary to make any additional nodes 
available in the Speed Port Configuration 
tool.

Note: If you have modified your Speed node file, (for example you may have changed the default 
permission for security reasons), you may wish to re-instate the previous node set-up for 
existing Speed ports. 
If you have not modified your Speed node file or do not require to retain the old settings you 
may safely delete the file shown in the first message.
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SCO OpenServer 5
SCO OpenServer 5 error messages

Error message Reason Action required

ERROR: unit @0xnnnnnnnn has bad 
resource(s)

Incorrectly installed or faulty 
card.
Incorrect BIOS settings.

1. Ensure that you have followed the 
installation procedure correctly. 
See  page 62.

2. Check BIOS settings.
3. If the problem persists try another card. 

See  page 62 and  page 10.

ERROR: unit @0xnnnnnnnn not 
mapped

Insufficient memory available 
to kernel.

1. Reconfigure system/kernel memory 
parameters.

ERROR: unit @0xnnnnnnnn not 
initialised

Incorrectly installed or faulty 
card.

1. Ensure that you have followed the 
installation procedure correctly.  
See  page 62.

2. If the problem persists try another card. 
See  page 62 and  page 10.

WARNING: unit @0xnnnnnnnn not 
configured

System error. 1. Uninstall the driver and remove all Speed 
cards from the system.  
See  page 76

2. Re-install the driver and cards taking care 
to follow the correct procedure. See  page 
62 and  page 10.

WARNING: No Speed ports 
configured

No cards installed.
Installed cards suffer from one 
or more of above symptoms.

1. Install cards. See  page 10.
2. Resolve any above listed faults.
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SCO UnixWare/SCO OpenServer 6
SCO UnixWare/SCO OpenServer 6
There are no messages displayed on the system at startup. Messages from the SPEED driver are sent 
to the syslog file in the /var/adm directory. Each entry in the syslog file is date and time stamped (You 
can review the content of the syslog file using a suitable text editor). Each time the driver is loaded, 
entries similar to those shown below indicate successful UltraPort card detection.

Driver software version

Total number of SPEED ports

Driver message - always displayed if installed and conlfigured

Host card type 

Host card ID number
IRQ level 

Apr 26 16:05:15 pwredge3 unix:  Perle Speed Unixware Driver v1.0.0 Apr 26 2003 15:56:35
Apr 26 16:05:15 pwredge3 unix: Copyright (c) 2003 Perle Systems Limited
Apr 26 16:05:15 pwredge3 unix: unit:0 - UltraPort16 card using IRQ:10 - OK
Apr 26 16:05:15 pwredge3 unix: unit:1 - UltraPort8 card using IRQ:15 - OK
Apr 26 16:05:15 pwredge3 unix: Total Speed Ports : 24

Apr 26 16:05:15 pwredge3 unix: unit:1 - UltraPort8 card using IRQ:15 - OK
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SCO UnixWare/SCO OpenServer 6
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Additional card warning messages
If you install more than one UltraPort, UltraPort SI or UltraPort Express host card, or install 
additional cards at a later date, the following warning messages will be displayed during system start-
up.

Note: Display of these messages and update of Speed Node and Init files only occurs once after 
installation of additional cards. This takes place during system start-up.

Message This message tells you that...

WARNING: Speed Node file updated 
- old file moved to /etc/conf/node.d/spd_nnnnnnnn

The speed node file has been updated to include
the revised number of ports.
Your old Speed node file is retained with the fil
name shown in the message. 'nnnnnnnn' is a 
unique number so that previous Speed node file
are not lost on updating.

WARNING: New Speed ports detected 
- /etc/conf/node.d/spd being updated

You now have additional entries in the Speed in
file, existing entries are retained unchanged. Th
automatic init file update is necessary to make 
any additional nodes available in the Speed Por
Configuration tool.

Note: f you have modified your Speed node file, (for example you may have changed the default 
permission for security reasons), you may wish to re-instate the previous node set-up for 
existing Speed ports. 
If you have not modified your Speed node file or do not require to retain the old settings you 
may safely delete the file shown in the first message.
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SCO UnixWare/SCO OpenServer 6
SCO UnixWare error messages 

Error message Reason Action required

ERROR: unit @0xnnnnnnnn has bad 
resource(s)

Incorrectly installed or faulty 
card.
Incorrect BIOS settings.

1. Ensure that you have followed the 
installation procedure correctly. 
See  page 77.

2. Check BIOS settings.
3. If the problem persists try another card. 

See  page 77 and  page 10.

ERROR: unit @0xnnnnnnnn not 
mapped

Insufficient memory available 
to kernel.

1. Reconfigure system/kernel memory 
parameters.

ERROR: unit @0xnnnnnnnn not 
initialised

Incorrectly installed or faulty 
card.

1. Ensure that you have followed the 
installation procedure correctly.  
See  page 77.

2. If the problem persists try another card. 
See  page 77 and  page 10.

WARNING: unit @0xnnnnnnnn not 
configured

System error. 1. Uninstall the driver and remove all Speed 
cards from the system.  
See  page 77

2. Re-install the driver and cards taking care 
to follow the correct procedure. See  page 
77 and  page 10.

Error: could not register interrupt 
handler for unit @0xnnnnnnnn

System error 1. Uninstall the driver and remove all Speed 
cards from the system.  
See  page 77

2. Re-install the driver and cards taking care 
to follow the correct procedure. See  page 
77 and  page 10.

WARNING: No Speed ports 
configured

No cards installed.
Installed cards suffer from one 
or more of above symptoms.

1. Install cards. See  page 10.
2. Resolve any above listed faults.

UX: sh (sh): ERROR: telinit: Not 
found
(Note this error occurs on UnixWare 2 
systems only)

telinit command not found None. The installation process takes care of 
configuring the kernel and ensures that SPEED 
ports are ready for use when the installation 
process is complete.

Unable to open device /dev/spd : No 
such device

No SPEED cards installed 
during driver installation.

1. Install cards. See  page 10.
Note that there is no need to uninstall and 
re-install the driver. When the system is 
rebooted, your SPEED cards will be 
detected and configured into the kernel.
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Microsoft Windows
Microsoft Windows
This section describes troubleshooting UltraPort, UltraPort SI, and UltraPort Express products under 
the Microsoft Windows family of operating systems. For Windows NT, see next section.

General troubleshooting under Windows

Windows error messages
In the event of any error messages, check the Windows Event Log. Also open the Windows 
Device Manager and check for warming icons on the installed hardware. See your Microsoft 
Windows user documentation or help system for details.

Note: To contact Perle for technical support go to the web page:
http://www.perle.com/downloads

Problem Action required

Machine fails to boot. 1. Turn off your machine, remove UltraPort card(s) and 
reboot. See  page 16.

2. Try installing a different host card in case the one 
currently installed is faulty. See  page 10.

Windows operating system fails while loading and 
the system hangs.

1. Reboot machine and then switch to the last known 
good configuration.

2. Check for resource conflicts or faulty hardware.

Windows operating system fails while loading and 
displays a blue screen.

1. Note the five hexadecimal numbers at the top line of 
the screen 

2. Reboot your machine and then switch to the last known 
good configuration.

3. Check for resource conflicts or faulty hardware.

Operating system loads OK, but SPEED driver or 
another driver fails to boot

1. Run Windows Device Manager to find available IRQ 
and memory addresses.

UltraPort ports do not work after installation. 1. Check the Windows Event Log and follow the 
suggested actions. 

SPEED Windows driver fails during normal 
operation, symptom: blue screen

1. Note the five hexadecimal numbers displayed at the top 
line of the screen.

2. Reboot your machine and then switch to the last known 
good configuration.

3. Check for resource conflicts or faulty hardware.

SPEED Windows driver fails during normal 
operation, symptoms either: 
 
black screen, machine reboots or system hangs

1. Contact Technical Support at Perle’s web page:
http://www.perle.com/downloads
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Windows NT
Windows NT
Windows NT general troubleshooting UltraPort and UltraPort SI only

In the event of any problems, open the Devices window to view the status of any installed hardware. 
For further details of troubleshooting under Windows NT, see your Windows NT user documentation 
or help system.
 131


	Serial Adaptors User’s Guide
	Table of Contents
	Introduction to UltraPort
	About the UltraPort, UltraPort SI, and UltraPort Express Serial Adaptor cards
	Connection accessories

	Installing/Removing Host Cards And Cable Accessories
	Introduction
	Installing UltraPort, UltraPort SI, and UltraPort Express cards
	Installing cables and connector boxes
	Installing cables on UltraPort1/2, UltraPort1/2 SI and UltraPort1/2 Express cards
	Installing converter cables on UltraPort4 (RJ-45) and UltraPort4 Express (RJ45) cards
	Installing converter cables on UltraPort8i cards
	Installing fan-out cables and connector boxes on UltraPort4-LP, UltraPort4 SI-LP, UltraPort4 Express HD, UltraPort8, UltraPort8 SI-LP and UltraPort8 Express HD cards
	Installing fan-out cables and connector boxes on UltraPort16 and UltraPort16 SI cards

	Removing host cards

	Installing On Microsoft Windows
	Installing Drivers
	General Information
	Downloading the driver from the Perle web site
	General setup procedure
	Installing device drivers and utilities onto your system
	Adding additional cards and/or updating drivers

	Configuring the Serial ports
	Removing Drivers
	Windows 95 and Windows 98
	Introduction
	General Installation Procedure
	Installing Device Drivers And Utilities
	Configuring your serial ports on Win 95/98
	Removing Drivers and Utilities From Your System

	Windows NT

	Installing On Linux
	Installing Drivers
	Introduction
	General installation procedure for Linux
	Downloading the driver from the Perle web site
	Installing Drivers onto your system
	Uninstall Patch Versions
	Install from Source RPM
	Install from Tar File
	Creating devices for the attached ports
	UltraPort 8i RTS/DTR option
	Setultrap Interface Protocol Configuration Utility (UltraPort SI only)
	Uninstalling the UltraPort Driver for Linux


	Installing On Solaris
	Installing The Driver Package
	Introduction
	Downloading the driver from the Perle web site
	General installation procedure for Solaris
	Installing drivers and utilities
	Serial port naming conventions
	Configuring serial ports using the Admintool
	Using The Solaris Management Console For Solaris 10
	Using SMF Services For Solaris 11
	Setultrap Interface Protocol Configuration Utility (UltraPort SI only)
	Removing drivers and utilities from your system


	Installing On SCO
	Introduction
	Downloading the driver from the Perle web site

	Installing under SCO OpenServer5 and OpenServer6.
	General installation procedure for SCO OpenServer
	Installing device drivers and utilities
	Serial port naming conventions
	Configuring serial ports
	Setultrap Interface Protocol Configuration Utility (UltraPort SI only)
	Removing drivers and utilities from your system

	Installing under SCO UnixWare
	General installation procedure for SCO UnixWare
	Installing drivers and utilities
	Serial port naming conventions
	Configuring serial ports
	Setultrap Interface Protocol Configuration Utility (UltraPort SI only)
	Removing drivers and utilities from your system


	Cabling Information
	Introduction
	Definitions of Signals and Direction
	Host card back panel connectors and pinouts
	DB9 back panel connectors and pinout
	RJ45 back panel connectors and pinout
	RJ12 back panel connectors and pinout
	VHDCI-68 Ultra SCSI back panel connectors and pinout

	Connector box and cable guide
	Connector box and cable pinouts
	RJ45 10-pin to DB25 converter
	RJ45 10-pin to DB9 converter
	RJ45 10-pin to RJ45 SPEED converter
	RJ45 10-pin to RJ45 Digi converter
	RJ45 10-pin to RJ45 Digi ALTPIN converter
	RJ45 connector box
	DB25 connector box
	DB9 connector box
	DB25 Fan-out cable
	DB9 Fan-out cable


	Transparent Printing
	Introduction
	What is transparent printing?
	Problems with printer output
	The printcap.spd configuration file
	The print.spd configuration file


	Operations for EIA- 422/EIA-485
	Introduction
	The EIA-422 Standard
	The EIA-485 Standard
	Many Masters / Many Slaves
	One Master / Many Slaves

	Cabling Distances

	Troubleshooting
	Introduction
	SCO OpenServer 5
	Example of normal SPEED driver boot messages
	Additional card warning messages
	SCO OpenServer 5 error messages

	SCO UnixWare/SCO OpenServer 6
	Additional card warning messages
	SCO UnixWare error messages

	Microsoft Windows
	General troubleshooting under Windows
	Windows error messages

	Windows NT



<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /Description <<
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000500044004600206587686353ef901a8fc7684c976262535370673a548c002000700072006f006f00660065007200208fdb884c9ad88d2891cf62535370300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef653ef5728684c9762537088686a5f548c002000700072006f006f00660065007200204e0a73725f979ad854c18cea7684521753706548679c300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /DAN <>
    /DEU <>
    /ESP <>
    /FRA <>
    /ITA <>
    /JPN <>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020b370c2a4d06cd0d10020d504b9b0d1300020bc0f0020ad50c815ae30c5d0c11c0020ace0d488c9c8b85c0020c778c1c4d560002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken voor kwaliteitsafdrukken op desktopprinters en proofers. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /PTB <>
    /SUO <>
    /SVE <>
    /ENU (Use these settings to create Adobe PDF documents for quality printing on desktop printers and proofers.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /NoConversion
      /DestinationProfileName ()
      /DestinationProfileSelector /NA
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure true
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles true
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /NA
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /LeaveUntagged
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


